
USERGUIDE

Configuration Management

Rel 10.2-MP3 (September 21, 2021)



© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 2

Table of Contents
Table of Contents 2

Configuration Management 4

Change Packages 6

Change PackageObjects 6

Change Package Privileges 10

Initial Setup for Change Packages 12

Creating a Change Package 16

Editing a Change Package 17

Set the OperationMode 17

Add Items to a Change Package 19

Reasons for Included Items 21

Ignore Auto-selectedObjects 21

Remove Items from aChange Package 23

Status and Discrepancies in Change
Package Items 24

Refresh Status 25

Compare Package Contents with Current 26

Accept Current Status 27

View Causes of Inclusion 27

Finalizing a Change Package 29

Seal a Change Package 29

Modify a Sealed Change Package 30

Export a Change Package 30

Analyzing and Installing Change Packages 32

Importing a Change Package 32

Analyzing a Change Package 32

Installing a Change Package 34

STEPXML Comparison Tool 36

STEPXML Comparison Tool Prerequisites 37

Configuration 39

Using the STEPXML Comparison Tool 48

Select Source and Target configuration file 48

Select how you want to filter the
configurations 48

Viewing configuration differenceswhen
‘Only In Source’ is selected for example 49

Viewing the differences in the comparison
tool 50

Generate STEPXMLwith the configuration
differences 51

STEPXML Comparison Tool Scenarios 53

Configurations for Exporting the Data 53

Considerations for STEPXML Imports 54

STEPXML Comparison Tool Limitations 56

Version Control System Integration 57

Configuration / Data 57

Information about VCS Integration 57

Integration Endpoint Plugins 58

Outbound Integration Endpoint 'STEPXML
Splitter' Post-processor Plugin 58

Split mode 58

Convert business rules to editable format 60

Outbound Integration Endpoint ‘Git Delivery’
Plugin 60

Remote Setup Example 64



© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 3

Inbound Integration Endpoint 'STEPXML
Joiner' Pre-processor Plugin 65

Inbound Integration Endpoint 'InvokeOIEP'
Post-processor Plugin 67

Outbound Endpoint Configuration 68

Inbound Endpoint Configuration 76

Editable Business Rules Format 77

Options for Export 82

Options for Import 83

REST Resources for Testing and Validation 84

VCS: Example Setups 86

SystemComparison 86

Semi-automated SystemSynchronization 88

VCS: Considerations and Limitations 91

Maintaining Partial Data Sets on Lower
Level DTAP Environments 92

STEPXML Export Basics 92

Export Size: Selected 94

Export Size: All 95

Export Size: Minimum 95

Export Size: Referenced 97

Including Ancestors 98

Asset Content 101

CrossContext Exports 102

Transferring Configuration and Data
Between Systems 102

Example 103

Transferring STEP Configuration and
Sample Data 107

SystemConfiguration Export and Import 107

Importing the Configuration-Export Export
Configuration 108

Using the Configuration-Export Export
Configuration 110

Importing the Configuration on the Target
System 114

Taking Post Import Actions 116

Sample Data: Export and Import 117

Importing the ProductDataSample-Export
Export Configuration 117

Using the ProductDataSample-Export
Export Configuration 118

Exporting Customer MDMSample Data 124

Importing the Sample Data on the Target
System 124



Configuration Management
Management of SystemSetup configurations acrossmultiple systems can be a complex process. In addition to
standard import / export functionality, STEP provides several tools to assist in configurationmanagement. Each of
these is described in the subsequent sections.

l Change Packages
l STEPXMLComparison Tool
l Version Control System Integration
l Maintaining Partial Data Sets on Lower Level DTAP Environments
l Transferring STEP Configuration and Sample Data

Export Configuration Definitions as Comments
Using Advanced STEPXML, configuration definitions for workflows,WebUIs, integration endpoints (IEPs), and
business rules can be exported. These exports are intended to be used for submission to external source control
systems for comparison purposes. Users can import them into source code repository systemswhere they can be
compared from version to version. Editing and/or import of these files is not supported (e.g., usersmay not export,
edit the comments, and re-import).

Inclusion of configuration definitions as comments is accomplished by setting the DefinitionsAsComments tag to
'true' in an Advanced STEPXML template.

For example:

More information on exporting configuration definitions as comments is available as follows:

l For workflow definitions, see theExporting Workflow Definitions topic in theWorkflows documentation.
l For WebUI definitions, see theExporting Web UI Definitions as Comments topic of theWeb User
Interfaces documentation.

l For inbound integration endpoint definitions, see theExporting Inbound Integration Endpoint Definitions
as Comments topic in theData Exchange documentation

l For outbound integration endpoint definitions, see theExporting Outbound Integration Endpoint
Definitions as Comments topic in theData Exchange documentation.

l For business rule definitions, see theExporting Business Rule Definitions as Comments topic of the
Business Rules documentation.
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Note: The content of the comment field is not part of the STEPXMLXSD and therefore Stibo Systems
reserves the right to change the format of the output content at any time.
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Change Packages
A change package allows for an easyway to prepare, process andmigrate STEP configuration changes between
systems in a larger system landscape. Change packages are designed to:

l Minimize offline tracking of configuration changes
l Lessen the chance for introducing faulty configuration changes
l Assist system administrators with impact analysis to enablemore informed decisionmaking

The overall flow of change packages is shown below:

Once created, a user may add or remove items from the package until they are satisfied with the contents. The
change package can then be sealed and exported for loading to another system. Upon loading of the change
package to the target system, an impact report can be run that helps identify areas that may need to be updated
prior to installation and could be impacted upon installation. This provides an indication to the user of how
successful the change package will be if applied. The user may then choose to remove or install the change
package. If installed successfully, the configurations contained in the change package will be loaded to the system
and available for immediate use.

Change Package Objects
Change packages are system setup objects that act as containers to house a set of configurations.
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Note: Change packages can include the following STEP objects: Action sets, Asset Importer, Attributes,
Attribute groups, Attribute transformations, BusinessRules, Classification Product Link Types, Completeness
Metric, Contexts, D&B, Dimensions, Dimension Points, Derived Events, Event processors, Event Queues,
GatewayEndpoints, Integration endpoints, Link Types, List of Values, Match Codes, Matching Algorithms,
Object Types and Structures, PIM Tables, Reference Types, Setup Entities, SetupGroups, Status Flags,
Sufficiency configurations, Unique keys, Units, Unit groups, Users and User Groups,WebUI configurations,
Workflows, and XSLT Style sheets.

Change Package Icons and Statuses

Icon Status Description

Open l Change package is in an editable state, therefore not final or ready for export yet. Packagesare open when
created and when re-opened from a sealed state

l Can have an impact report run only if previously sealed
l Cannot be exported
l Itemscan be added and removed
l Packages can be deleted and the itemswithin them are left on the system unchanged

Sealed l Change package is locked for editing and ready for export
l Can have an impact report run
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Icon Status Description

l Can be exported
l Itemscannot be added or removed
l Packages can be deleted and the itemswithin them are left on the system unchanged

Dormant l Change package hasbeen imported from another system but not yet installed
l Can have an impact report run
l Can be exported
l Itemscannot be added or removed
l Packages can be deleted and there is no impact to the itemswithin them. If the package hasbeen previously

installed, the itemswithin the package are left on the system unchanged. If the package hasnot yet been installed,
the itemswithin it are no longer available for installation.

Change Package Tab

Flipper Description

Provides basic information about the change package, including the Status, whether or not the
change package has been exported, whether or not the package has been sealed, and where the
package is originally from (e.g., created on the current system or imported from another system).
If the package has been sealed or an impact report has been run on the package, additional fields
will be present with links to these processes.

Primary
Items

Displays a list of objects that have been directly added to the change packages, aswell as
providing the interface for adding and removing items from the change package. Users can select
to add a single object (Add Item), or an object and all of its child objects (Add Hierarchy).

Items in this list are part of the change package and will be created and/or updated on the target
systemwhen the change package is installed.

Secondary
Items

System generated list of objects that are part of the change package due to the addition of a
parent using the Add Hierarchy option. This list can only be edited by adding or removing the
driving primary item.

Items in this list are part of the change package and will be created and/or updated on the target
systemwhen the change package is installed.

Items
Required
For
Transfer

System generated list of objects that are required for the change package due to interactionswith
the selected objects. This list can only be edited by adding or removing the driving primary item.

These objects are essentially prerequisites for the transfer as the selected primary objects and/or
the secondary objects have some dependency on them. The objects are included in the change
package as ameans of ensuring that the primary and secondary items are successfully
transferred, and will be created and/or updated on the target systemwhen the change package is
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Flipper Description

installed.

Possibly
Impacted
Items

System generated list of items that might be affected by the transfer of the change package on
the new system. This list can only be edited by adding or removing the driving primary item.

These objects are dependent in someway on the primary or secondary object, but are not
required for configuration of those objects and are therefore not included in the change package.
Theywill only bemodified if they already exist on the target system.

Log Tab
The Log allows administrators tomonitor modifications to change packages. This information, along with the data
displayed directly on the change packages, provides detailed logging and tracking for comprehensive audit trails.

In addition, when an item is added to a change package or removed from a change package, the log of the item
itself is also updated accordingly.
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Change Package Privileges
In order to use change packages, the user must be part of a user group that has an unrestricted setup action set
applied to it (e.g., has a Setup Privilege defined that includes the 'All Setup Actions' action set. This action set must
include all setup actions, including the 'Maintain change package' action.

As an administrator, to make sure that the All Setup Actions action set has 'Maintain change package' in it, in
SystemSetup go to Action Sets > Setup Actions > All Setup Actions.

In the list to the right, if theMaintain change package action does not exist, scroll to the bottom of the list and
selectAdd Action. This will populate a list of actions that are available to add to this set.
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Note: In addition to theMaintain change package action, theAll Setup Actions action set must contain all
setup actions. If any actions are present in theAdd Action pop up, thesemust also be added to theAll Setup
Actions action set in order to enable full use of change package functionality.

Once it has been verified that theAll Setup Actions action set does in fact include all setup actions, any users
requiring access to change package functionalitymust be part of a user group that has theAll Setup Actions
privilege applied.

For more information, see theUsers and Groups topic or theAction Sets topic within theSystem Setup /
Super User Guide documentation.

For information on including users in a change package,
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Initial Setup for Change Packages
In order to create a Change Package that will process andmigrate STEP configuration changes, the basic change
package configurationmust first be in place as defined below.

Change Packages functionality was introduced in version 7.4.

1. On SystemSetup, selectObject Types and Structures > Basic Object Types, and verifyChange
Package exists.

2. Under Setup Group type root right-click to create aNew Object Type.

3. UnderBasic Object Types node, return to the Change Package object.
4. On the References tab, clickAdd Parent link. Select the folder you created for change packages under Setup

Group type root and click the Select button.
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5. On theMaintainmenu, navigate to Insert, and selectSetup Group Root to open the 'Create SetupGroup
Root' dialog.
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6. Select the Change Packages object type that you created above, enter an ID and Name, and click theCreate
button. This creates a folder in SystemSetup where you can then create individual change packages.
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See theCreating a Change Package topic for details on the next step.
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Creating a Change Package
To create a Change Package, youmust complete the Initial Setup for Change Packages topic of this
documentation.

1. On the SystemSetup tab, locate the folder established for holding Change Packages.
2. Right-click the folder and selectCreate Package.

3. In the Create Change Package dialog, assign an ID and a name to the package and click theCreate button.

For details on adding items and working with change packages, see theEditing a Change Package topic of this
guide.
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Editing a Change Package
A change package serves as a container to store a set of system configurations for migration to another system.
Therefore, once a change package has been created, it is considered empty until one or more items have been
added to it. When objects have been added, the system then trackswhether or not subsequent changes occur on
those items. Information on the change package informs the user of whether or not an item in the change package
is up to date when compared to the current system configurations. Users then have the option to resolve
discrepancies. Details for working with open change packages are described below.

After editing a change package, before exporting, youmust finalize the package as defined in the Finalizing a
Change Package topic.

Users in Change Packages
When users and/or user groups are added to a change package, passwords for the users are not included. Since
creating a new user requires a password, new users cannot be created via STEPXML import. However, changes
to existing users can be imported.

Note:When changing a user from one assigned group to another, the user is added to the new group, but
must bemanually removed from the original group.

Importing a change package that includes users is only successful for users that already exist in the target
(receiving) system. Importing users that do not already exist results in themessage: 'The tag <user> requires the
attribute Password. The user with ID <id> was skipped.'

Set the Operation Mode
TheOperationMode determines how the dependency analysis will function for a given change package.
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Set the OperationMode as follows:

l Full: This default settingmeans all objects that aremanually added to the change package will, in turn, have all
of their associated items included in the change package. This automated inclusion pulls in not only items that
the object touches (references, workflows, etc.), but also objects touched by those items. For example, if an
attribute is valid on two object types, each of those two object types is also added to the package.

l Validity Ignored: This optionmeans the change package ignores associationsmade as a result of valid
attributes, object types, and reference typeswhen the dependency analysis ismade. For example, when the
user adds an attribute in thismode, the object types and references on which the attribute is valid are not
automatically added, whereas theywould be in 'Full' mode.

Important: Use caution when running a change package inValidity Ignored operationmode.With this
mode, installing the change package on a target can have an uncertain outcome. For example, if business
rules are beingmoved from one system to another via the change package, any binds associated with
those business rules are ignored, which can result in the business rules having a larger effect than intended
on the receiving system. The same holds true for attribute validations.

Changing the operationmode displays a prompt to run the dependency analysis. The analysis can be run at the
time of the prompt or at a later stage in the change package.
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Add Items to a Change Package
You can select any number of objects to be added to the package using theAdd Item andAdd Hierarchy links
under the Primary Items flipper as defined below.

1. On the Add Item dialog, select an item and click theSelect button.

l Add Item adds a single primary item to a change package. For example, selection of an attribute group will
add the attribute group only and no child attributes of the group.

l Add Hierarchy adds an object and all children of that object (direct children and beyond). The selected
object is added as a primary object, and all children are added as secondary objects. For example, selection
of an attribute group will add the attribute group as a primary item, and all children of the group as secondary
items. If the group includes other attribute groups, those groups and their attributeswill also be included as
secondary items.

Note: Selecting an invalid object type reports the issue in red text at the bottom of the Add dialog and the
Select button is not enabled.
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Added items are displayed in the Primary Items list.

2. Right-click on the change package and select ‘Update Included Items’ to ensure an accurate report of the
package dependencies.
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Note: In order to allow for easy addition of primary objects, full dependency calculations are only applied on
demand rather than running a potentially complex analysis for each individual addition or removal of an
object.

3. For more information on the items in the Primary Items flipper, see theStatus and Discrepancies in
Change Package Items topic.

Reasons for Included Items
To understand the reason an item is included in a change package, right-click on the arrow next to the item and
select the 'View cause of inclusion' option.

Ignore Auto-selected Objects
Users can ignore items listed in the Items Required For Transfer andPossibly Impacted Items sections.
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Note: Ignoring an item does not necessarilymean that the number of included items in the change package
will diminish.

For either section, in theHandling column for the unneeded item select Ignore. However, the results of ignoring
items are different based on the section, as defined below:

l In the Items Required For Transfer section:

The Ignore settingmeans that while the items are still part of the package, when the package is transferred
over to the receiving system, these itemswill not be installed on the target system. In addition, these items are
not evaluated or included in the impact report. This is especially useful if a user knows that a particular item is
set up correctly on the receiving system and / or wants to isolate a particular set of objects for transfer without
accounting for the full dependency analysis.

TheUse settingmeans the object transfers over to the receiving system.

l In thePossibly Impacted Items section the Test and Ignore settings provide communication between
administrators creating change packages and those that are deploying them on target systems.

The Test setting tells the installer that there are potential impacts to this object and it should be tested
accordingly.

The Ignore setting indicates that the package creator is confident in the outcome of the deployment and
additional testing on the specified object is not needed. The user will not see them reported on the impact
report when it is run. For more information on impact reports, seeAnalyzing and Installing Change
Packages in theConfiguration Management documentation.
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Important:When an item is deleted from the 'Primary Items' folder and then added back, the system does not
retain items initially Ignored in either the 'ItemsRequired for Transfer' or 'Possibly Impacted Items' sections.
The items are added backwith the re-addedPrimary Item, andmust bemanually set to Ignore again.

Remove Items from a Change Package
Only 'Primary Items' may be removed from a change package.

1. Verify the change package is open. Itemsmay only be removed from an open package.
2. In the Primary Items flipper, click the row arrow on the item(s) and selectingRemove items.

3. Right-click the change package and select the ‘Update Included Items’ option. This ensures an accurate report
of the dependencies in the package. Full dependency calculations are only applied on demand rather than
running a potentially complex analysis for each individual removal of an object.
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Status and Discrepancies in Change Package
Items
When an item is placed into a change package, the system tracks the details of the object from that point forward.
If the selected object is changed, the change package notes a discrepancy between the stored version and the
current version.

Each item in a change package has a color indicator and a notation of how long it has been since the object in the
change package has been compared to the current system state.

l AGreen indicator means the object reflected current status when it was last compared to the system.
l A Yellow indicator means that the object has been changed since it was added to the package, but that the
change has been accepted.

l A Red indicator means that the object has changed since addition to the change pack and changes to this
object have not yet been accepted.

Additionally, some objects are treated differently in regards to how they are tracked. This is indicated by the
background color of the objects in the Items column.

l A Dark Yellow highlight indicates that the objects needs to be verifiedmanually. These are objects that
cannot have their contents or details tracked, such as aWebUI, and are not reported on in the impact report.

l A Light Yellow highlight indicates that the object is part of the system’s base configuration, and cannot be
moved from one system to another via a change package.
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Important: At the time of sealing, the change package pulls the current system version of all objects included
in the change package. Therefore, all objects will have a green indicator upon sealing of the package.
Following sealing, objects can still be refreshed and if a subsequent discrepancy arises, the object will have a
red indicator. However, the option to accept the change will not be available as the package has been sealed
and an export of the change package will include all objects as theywere at the time the package was sealed.

Refresh Status
Refreshing an item sets the counter back to zero and updates the color indicator on the object.

To check the status of items in the change package, click on the row arrow in the item(s) and selectRefresh
Status.

The refresh option is available on all change package objects, regardless of their current status or the status of the
change package.
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Compare Package Contents with Current
For a detailed comparison of a change package object (or objects) and the current system, right-click the package
and select the 'Compare package contents with current' option.

In the case of large STEPXML files, the amount of memory needed to do the comparisonmay become excessive,
causing the comparison to be skipped. If this happens, the text is highlighted yellow (as shown below):
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Accept Current Status
If an object has changed since addition to the package, it has a red color indicator and theAccept Current
Status action is available on the row arrow right-clickmenu.

Accepting the current status of an item turns the color indicator yellow. This informs the user that the object has
changed since addition to the package, but that the change has been verified and the current object is accepted as
part of the package.

Note: This option is only available for objects that are not up to date and are part of an open change package.
If the package has been sealed this option is not available, regardless of object status.

View Causes of Inclusion
The 'View causes for inclusion' option is visible on items for the following flippers:
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l Secondary Items
l ItemsRequired for Transfer
l Possibly Impacted Items

Note: You canmulti-select items in the change package and run the 'View cause for inclusion.'

Select the 'View causes for inclusion' action to launch the 'ItemsCausing Inclusion' dialog. This shows the item(s)
that is / are the cause for inclusion on the given item selected in the change package.

Note: You cannot click the object in the dialog to view the object itself.
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Finalizing a Change Package
When the contents of a change package have been confirmed, it is sealed to indicate that no further edits will be
made and the package is ready for export.

Seal a Change Package
Once a change package has been determined as ready for export, it must be sealed.

Important: Sealing a change package pulls the current system version of all objects included in the change
package.

Prior to a change package being sealed, it has a blue open box icon ( ) and the 'Signed' field is populated with
'Not yet sealed.'

1. Right-click the package and select theSeal Package option.

The sealed package displays a closed box icon ( ) and the Signed field indicates the date, time, and user
responsible for the sealing. In addition, a link to the sealing background process is provided.
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Modify a Sealed Change Package
Re-opening a sealed change package allows the user to edit the change package.

1. Right-click the change package and select theRe-open Package option.

2. Follow the steps in theEditing a Change Package topic to modify the change package.

For more information on the items in the Primary Items flipper, see theStatus and Discrepancies in Change
Package Items topic.

Export a Change Package
Change packages are exported using the standard Export Manager functionality, and can be imported to target
systems using the Import Manager.

1. Verify the change package is sealed or dormant as defined in theChange Packages topic.
2. Right-click the package and select theExport Package option.
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3. On the Export Manager dialog, select a deliverymethod and finish the export, as defined in theExport
Manager - Select Delivery Method topic of theData Exchange documentation.
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Analyzing and Installing Change Packages
As themain purpose of a change package is to transfer configurations between systems, once a change package
has been sealed and exported from a source system, it is expected that it will then be imported to a target system.
Upon import, the change package can be analyzed against the target system data set, and subsequently installed
if desired.

Importing a Change Package
Change packages are exported as encoded STEPXML files and are therefore easily imported using the Import
Manager. For more information on the Import Manager, see the Import Manager documentation.

Note: It is required to create the setup group for change packagesmanually on the target system before you
can import a change package. For more on creating the setup group, see the 'Initial Setup for Change
Packages' section of the ConfigurationManagement documentation.

Upon import, the new change package is found in the same location on the SystemSetup tab as it existed on the
source system. Imported change packages have a status of 'Dormant' and a gray icon:

Note that the contents of the change package have not yet been applied at this point. Only the change package
itself has been imported, and no system configurationswill be updated unless the change package is installed.

Analyzing a Change Package
Once a change package has been imported, an impact report can be run. The impact report provides the user with
a variety of information they can use to assesswhether or not the change package should be installed, and what
the system impacts are likely to be upon installation.

To run an impact Report, right-click on the Change Package and selectStart Impact Report.
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The impact report is run as a background process, which is then accessible on theBG Processes tab under
Analyze Change Package. The contents of the report can be viewed directly in the execution report, or can be
downloaded for viewing offline (e.g., in Excel). A link to the background process is also provided on the change
package object.
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The impact report should be analyzed to determine whether or not the change package should be installed, and if
any changes should be carried out on the target system prior to installation. If system changes occur, it may be
useful to re-run the impact report.

If it is determined that the change package should not be installed, it can be removed from the system by right-
clicking on the change package and selectingDelete.

Note: Deleting a change package removes it from the system entirely. It is not available in the Recycle Bin and
can only be accessed again via re-import of the package.

Installing a Change Package
When the impact report has been reviewed and the change package determined acceptable, it is installed by right-
clicking and selecting Install Package Contents.
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Installation of the change packagemeans that all objects within the change package are added to the system. If
objects in the change package existed previously on the system, theywill be updated to reflect the contents of the
package.

Considerations
l The deletion of system configurations is not supported. Import of change packages supports configuration
additions only.

l Event queues and IEPs are imported as disabled andmust bemanually enabled.
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STEPXML Comparison Tool
Important: The STEPXMLComparison Tool has been superseded by the change packages functionality
available in Stibo SystemsEnterprise Platform (STEP)Workbench andmay be removed in a future release. It
is recommended that users transition to using change packages, which are described in theChange
Packages section of theConfiguration Management documentation.

STEP has a tool for comparing system setup on different instances of STEP. The comparison tool requires an
XML file to be exported from the source system and the target system.

This can be used to identify:

l Configuration that is different
l Compare collections, bulk update configurations and export / import configurations
l Configuration that only exists on the source system
l Configuration that only exists on the target system to identify what needs to be deleted
l Configuration that is identical

Once the differences have been identified the system compare tool can then be used to do the following:

l Generate an XML file of just the differences theywish to add to another STEP system.
This data can then be imported to the target system

l Generate an XML of all the differences and import onto the target system

The comparison tool should not be used tomigrate assets, products, classifications and entities from one system
to another. It should only be used to compare two STEP systems and from this comparison generate STEPXML
tomove this configuration from a source system to a target system

The tool will only add / modify configuration on target systems it will not delete what should not exist on the target
system. It will not make updates that require user input; this is explained in the document in more detail later in the
document.

See the following topics for more information:

l STEPXMLComparison Tool Prerequisites
l STEPXMLComparison Tool Limitations
l STEPXMLComparison Tool Scenarios
l Using the STEPXMLComparison Tool
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STEPXML Comparison Tool Prerequisites
Typically this type of work requires a STEP Super User to carry out the task. The user would require in depth
knowledge of STEPXML, SystemSetup, and how to use export and import manager.

Accessing the System Compare Tool
To access the STEP SystemAdministration data, the user must have Super Users privileges, i.e., be an
administrator of the system. The user will require all the privileges necessary tomake the updates the imported
XML requires.

Important: A lot of memory is required to run this tool, therefore the STEPXMLComparison Tool has been
superseded by the change packages functionality andmay be removed in a future release. It is recommended
that users transition to using change packages, which are described in theChange Packages section of the
Configuration Management documentation.

Go to File > Export > Compare SystemSetup Exports... to display theCompare System Setup Exports dialog.
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Moving configuration without using the STEP comparison tool
It is possible tomove configuration from one STEP instance to another without using the comparison tool.
This processwill only add / modify configuration loaded onto a target system. If you then need to identify what is
different from the source and target machines the comparison tool will need to be used.

Move all configurations from one STEP system to another
l Back-up target system
l Export XML fromSource system excluding assets, classifications, products, and entities
l Run aCrossContext export if configuration is stored inmore dimension points, i.e., LOVs, attribute names,
etc.

l Import onto target system
l Check execution report for errors and resolve

What configuration can be moved from one system to another?
Before a user can use the comparison tool the STEP export manager needs to be used to export STEPXML from
the source and target systems.

When configuring the export the following will need to be selected:

l Add the parent node for configuration files being which need to bemoved from the source to the target
If this is not done the import will fail on import the configuration files as the folder it resides in will not exist

l Select the STEP configurations that need to be exported
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All parameters available in the Export Manager are defined in theSTEPXML Outbound Parameters topic in the
Data Exchange documentation. TheGlobal Settings, Data Objects, and Publishing options are not valid for the
STEPXMLComparison Tool.

Only the Configuration parameters in Export Manager for the STEPXML format are available for comparison with
this tool as shown in the following section.

Configuration
Configuration
Parameter

Description

Include Action
Sets

SelectNo or Yes to control output of a list of all actions applied to each action set.

For more information, seeAction Sets in theSystem Setup / Super User Guide.

Include Asset
Push Event
Queues

Asset push event queues are exported as follows:

l SelectAll to output all asset push event queues.
l SelectSelected to output all asset push event queues based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no asset push event queues.

Include Asset
Push
Configurations

Asset push configurations are exported as follows:

l SelectAll to output all asset push configurations.
l SelectSelected to output all asset push configurations based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no asset push configurations.

Include
Attributes

For attributes, the validation base types, dimension dependencies applied units, applied
LOV hierarchy filters, calculated templates, and so on, are exported as follows:

l SelectAll to output all attributes, including fundamental system specific attributes
(having an ID that starts with stibo. or asset.).

l SelectSelected orMinimum to output attributes based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no attributes.

For more information, seeAttributes in theSystem Setup / Super User Guide.

Include Attribute
Groups

For attribute groups, the view definitions and settings applied to attribute groups are
exported as follows:

l SelectAll to output all attribute groups.
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Configuration
Parameter

Description

l SelectSelected orMinimum to output attribute groups based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no attribute groups.

For more information, seeAttribute Groups in theSystem Setup / Super User Guide.

Include Attribute
Transformations

SelectNo or Yes to control output of attribute transformations and their configurations.

For more information, seeAttribute Transformations in theSystem Setup / Super
User Guide.

Include Bulk
Update
Configurations

Assets saved as bulk update configurations are exported as follows:

l SelectYes to output all bulk update configurations.
l SelectMinimum to output bulk update configurations based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNo to output no bulk update configurations.

For more information, seeBulk Updates.

Include
BusinessRules
(Global) and
Libraries

For global business rules and libraries, the ID, name, links, on approve setting,
dependencies, valid object types, and templates are exported as follows:

l SelectAll to output all global business rules and libraries.
l SelectSelected orReferenced to output attributes based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no global business rules or libraries.

Templates are exported in Base64 and can only be imported without modifications into
another STEP system.

For more information, seeBusiness Rules.

Include
Collection
Definitions

SelectNo or Yes to control output of collections groups and collections, including search
URLs. The exported file will not contain products, classifications, or assets included in a
collection.

For more information, seeCollections in theGetting Started / User Guide.

Include
Component
Models

SelectNo or Yes to control output of details of component models, including ID, name,
object types and links. The Component Model node in SystemSetup displays all available
component models on your system.
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Configuration
Parameter

Description

For more information, see theComponent Models topic in theSystem Setup / Super
User Guide.

Include
Contexts

SelectNo or Yes to control output of dimensions, dimension points, contexts, applied
dimension points, and locale settings.

For more information, seeContexts in theSystem Setup / Super User Guide.

Include Context
Qualifiers

SelectNo or Yes to control output of a list of qualifiers used in exported data. When used in
combination with export of product, classification, or asset data, controls qualifier IDs and
dimension point IDs.

For more information, seeContexts in theSystem Setup / Super User Guide.

Include Data
Container
Definitions

Data container types are exported as follows:

l SelectAll to output all data container types.
l SelectSelected orMinimum to output data container types based on the explanation in
theMinimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no data container types.

For more information, seeData Containers in theSystem Setup / Super User Guide.

Include Derived
Event Types

SelectNo or Yes to control output of objects created in SystemSetup asDerived Event
Type.

For more information, seeDerived Events in theSystem Setup / Super User Guide.

Include
eCatalogs

SelectNo or Yes to control output of eCatalog configurations and price lists. Does not
include product selection lists.

For more information, see eCatalogs.

Include Event
Processors

Control output of event processor information, including ID, name, links, and configuration.

l SelectAll to output all event processors.
l SelectMinimum to output event processors based on the explanation in theMinimum,
Referenced, and Selected in STEPXML documentation.

l SelectNone to output no event processors.

For more information, seeEvent Processors in theSystem Setup / Super User Guide.
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Configuration
Parameter

Description

The configurations are exported in Base64 and can only be imported without modifications
into another STEP system.

Include Event
Queues

SelectNo or Yes to control output of event queues and appliedmessage templates, output
formatting, and triggering definitions.

Include Export
Configurations

Assets saved as export configurations are exported as follows:

l SelectAll to output all export configurations.
l SelectMinimum to output export configurations based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no export configurations.

For more information, seeMaintaining a Saved Export Configuration inData
Exchange.

Include Image
Conversion
Configurations

Image conversion configurations are exported as follows:

l SelectAll to output all image conversion configurations.
l SelectSelected orMinimum to output image conversion configurations based on the
explanation in theMinimum, Referenced, and Selected in STEPXML
documentation.

l SelectNone to output no image conversion configurations.

Include Import
Configurations

Assets saved as import configurations are exported as follows:

l SelectAll to output all import configurations.
l SelectMinimum to output import configurations based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no import configurations.

For more information, seeMaintaining a Saved Import Configuration inData
Exchange.

Include
Integration
Endpoints

Control output of integration endpoint ID, name, and configurations. The configurations are
exported in Base64 and can only be imported without modifications into another
STEP system.

l SelectAll to output all integration endpoints.
l SelectSelected to output only integration endpoints in the selected hierarchy based on
the explanation in theMinimum, Referenced, and Selected in STEPXML
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Configuration
Parameter

Description

documentation.
l SelectNone to output no integration endpoints.

For more information, see the integration endpoint topics inData Exchange.

Include Key
Definitions

SelectNo or Yes to control output of definitions of objects created as keys.

For more information, see theUnique Keys in theSystem Setup / Super User Guide.

Include Link,
Reference and
Object Types

Important: Handle reference types and object typeswith an ID that start with stibo.
carefully since they are fundamental objects.

System specific object types, link types, and system specific reference types are exported
as follows:

l SelectAll to output all edge, reference, and object types.
l SelectSelected orMinimum to output only link, reference, and object types in the
selected hierarchy based on the explanation in theMinimum, Referenced, and
Selected in STEPXML documentation.

l SelectNone to output no link, reference, and object types.

For more information, seeReference and Link Types in theSystem Setup / Super
User Guide.

Note: Edge types are identified with either 'PA' (product to attribute link type) or 'CA'
(classification to attribute link type).

Include List of
Values

LOV definitions and values in LOVs, including appliedmeta attributes, validation base
types, and applied units are exported as follows:

l SelectAll to output all LOV definitions and values.
l SelectSelected orMinimum to output LOV definitions and values based on the
explanation in theMinimum, Referenced, and Selected in STEPXML
documentation.

l SelectNone to output no LOV definitions or values.

For more information, see List of Values (LOVs) in theSystem Setup / Super User
Guide.

IncludeMatch SelectNo or Yes to control output of match code information, including ID, name, links,
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Configuration
Parameter

Description

Codes setup group, valid entity hierarchies, and valid object types.

For more information, see theMatching, Linking, and Merging documentation.

Include
Matching
Algorithms

Control output of matching algorithms, including ID, name, links, and configuration.

For more information, see theMatching, Linking, and Merging documentation.

l SelectAll to output all matching algorithms.
l SelectSelected to output matching algorithms based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output nomatching algorithms.

The configurations are exported in Base64 and can only be imported without modifications
into another STEP system.

Include Setup
Entities

Control output of setup entities including ID, name, links, and configuration. The
configurations are exported in Base64 and can only be imported without modifications into
another STEP system.

l SelectAll to output all setup entities.
l SelectSelected to output setup entities based on the explanation in theMinimum,
Referenced, and Selected in STEPXML documentation.

l SelectNone to output no setup entities.

Include Setup
Groups

Control output of setup groups that are defined in system setup to hold integration
endpoints, WebUI configurations, STEP workflows, and business rules.

l SelectAll to output all setup groups.
l SelectSelected to output setup groups based on the explanation in theMinimum,
Referenced, and Selected in STEPXML documentation.

l SelectNone to output no setup groups.

For more information, seeSetup Groups in theSystem Setup/ Super User Guide.

Include Status
Flags

Workflow status flags are exported as follows:

l SelectAll to output all workflow status flags.
l SelectSelected to output workflow status flags based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no workflow status flags.
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Configuration
Parameter

Description

For information, see theStatus Flags topic inWorkflows documentation.

Include System
Settings

SelectNo or Yes to control output of the following default settings defined on the Users and
Groups root node:

l Image & Document Settings flipper > Dimension Dependencies
l Calculated Attribute Settings flipper > Dimension Dependencies
l Product Information Manager Default Settings flipper
l Flatplanner Default Settings flipper
l DTP Default Settings flipper
l GDSN Default Settings flipper
l Terms List Settings flipper
l WebServicesDefault Settings flipper
l WebUI Default Settings flipper
l Default Reference Type of Primary Image flipper
l Table Default width and height flipper

For more information, seeSystem Settings in theSystem Setup/ Super User Guide.

Include Table
Types

Row type definitions, column type definitions, and table type definitions, including applied
transformations are exported as follows:

l SelectAll to output all table types.
l SelectMinimum to output table types based on the explanation in theMinimum,
Referenced, and Selected in STEPXML documentation.

l SelectNone to output no table types.

For more information, see Tables.

Include Tags SelectNo or Yes to control output of style tags, character tags, special characters,
footnotes, and hyperlinks, including information about rendering, short cuts, and applied
output formatting.

For more information, see Tags in theSystem Setup/ Super User Guide.

Include
Transformation
Lookup Tables

Assets saved as transformation lookup table configurations are exported as follows:

l SelectAll to output all transformation lookup table configurations.
l SelectMinimum to output transformation lookup table configurations based on the
explanation in theMinimum, Referenced, and Selected in STEPXML
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Configuration
Parameter

Description

documentation.
l SelectNone to output no transformation lookup table configurations.

For information, see the Transformation Lookup Tables topic inResource Materials
online help.

Include
Translation
Configurations

Saved translation configurations are exported as follows:

l SelectAll to export all saved translation configurations.
l SelectSelected to export selected saved translation configurations based on the
explanation in theMinimum, Referenced, and Selected in STEPXML
documentation.

l SelectNone to export no saved translation configurations.

For information on saving translation configurations for data objects, see theStarting a
Structured Translation topic. For information on saving translation configurations for
setup objects, see theStructured Translation for Setup Objects topic.

Include Units Unit groups and units, including appliedmeta attributes, values, and base unit conversions
are exported as follows:

l SelectAll to output all unit groups and units.
l SelectSelected orMinimum to output unit groups and units based on the explanation
in theMinimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no unit groups or units.

For more information, seeUnits in theSystem Setup/ Super User Guide.

Include Users
and User
Groups

Control output of all user groups and users, including information about applied privileges,
meta attributes, restricted GUI setup, etc.

User passwords are not included in the output. Since creating a new user requires a
password, new users cannot be created via STEPXML import. However, changes to
existing users can be imported.

Note:When changing a user from one assigned group to another, the user is added to
the new group, but must bemanually removed from the original group.

l SelectAll to output all users or user groups. The Select Objects step allows you to limit
the users and/or groups after setting the Export parameter to All, use the AddObjects
link to define the objects to export.
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Parameter

Description

l SelectSelected to output users or user groups based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output no users or user groups.

For more information, seeUsers and Groups in theSystem Setup/ Super User Guide.

IncludeWebUI
Configurations

Control output of WebUI configurations in the exported file.

l SelectAll to output all WebUI configurations.
l SelectSelected to outputWebUI configurations based on the explanation in the
Minimum, Referenced, and Selected in STEPXML documentation.

l SelectNone to output noWebUI configurations.

For more information, seeManaging Web UI Configurations in theWeb User
Interfaces / Web UI Setup and User Guide.

Include
Websites

SelectNo or Yes to control output of websites, with and without workspace.

The legacy ‘Web Publisher’ used this option to publish data incrementally fromSTEP.
OIEPs provide improved functionality for this same purpose. For more information, see the
Data Exchange.

Include
Workflows

Workflow information, including ID, name, links, valid object types, and configuration are
exported as outlined below. The configurations are exported in Base64 and can only be
imported without modifications into another STEP system.

l SelectAll to output all workflows.
l SelectSelected to output workflows based on the explanation in theMinimum,
Referenced, and Selected in STEPXML documentation.

l SelectNone to output no workflows.

For more information, seeWorkflows.

Include
Workflow
Profiles

Workflow profiles (including information such as number of exceeded deadlines, how long
the tasks have been assigned to the assignees, what is the workflow throughput for the
month versus the last sixmonths, etc.) are exported as follows:

l SelectAll to output all workflow profiles.
l SelectSelected to output workflow profiles based on the explanation in theMinimum,
Referenced, and Selected in STEPXML documentation.

l SelectNone to output no workflow profiles.

For more information, seeMonitoring Workflows.
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Using the STEPXML Comparison Tool
The information below outlines how you can use the comparison tool to compare a source and target system.

Select Source and Target configuration file
Once a user has logged into the comparison tool theywill firstly need to select XML exported from the source
system and XML exported from the target system as illustrated below:

1. Select the exported XML file from the source system
2. Select the exported XML file from the target system

Select how you want to filter the configurations
Once the XML files have been selected the user will need to select how the comparison tool should filter the
differences.

l Only in Source – Filter on configurations that only exist on the source system
l Only in Target – Filter on configurations that only exist on the target system
l Different – Filter on what is different between the source and target system
l Identical – Filter on what is identical between the source and target system
l Compare Files – Once selected the relevant configuration will be highlighted depending on the filter options
selected above

If you need to change the filter options selected, change them and click Compare Files to update
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Viewing configuration differences when ‘Only In Source’ is selected for example
Outlined below is an example of how to filter what is only in the source XML file.

The comparison tool will give an overview of the following:

l Only In Source
l Only in Target
l Different
l Identical

In this example the user has selected to filter on ‘Only In Source’, when the user opens the attribute list
configuration which indicates one attribute the user is shown the attributes that appear in the source system only.

Note: If you select the Expand All option the user is shown all configurations related to the filter selected i.e.,
Only In Source.
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Viewing the differences in the comparison tool
Within the comparison tool users are able to view what the difference is between the XML files from source and
target systems.

If there are differences for each of the filters between the source and target systems users are able to view these
differences by selecting the hyperlink for each difference

If you select the hyperlink highlighted in screenshot above you will be shown the STEPXML for the List Of Values
group that only exists in the source system as follows:
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Generate STEPXML with the configuration differences
Finally the user will need to select the check boxes to identify the configuration required to be exported and then
generated an XML file based on this selection.

1. Select the configuration that needs to bemoved to the target system. In this case it is the List Of ValuesGroup
List.

2. Check Single UpdateMode option
3. If STEPXML generated needs tomake updates that require single updatemode this optionmust be checked.

Examples of what puts a system into Single UpdateMode are given later in the document
4. Generate STEPXML by hitting the Generate STEPXML button
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5. Save XML file and name appropriately
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STEPXML Comparison Tool Scenarios
The following examples highlight how the STEPXMLComparison Tool can be used.

Running and loading STEPXML generated via the comparison tool
It is advisable to run the STEP comparison tool when no one is using the system. The XML being loadedmay
require ‘Single-UpdateMode’ and entering Single-UpdateModemeans users only have read-only access to the
system.

If you load XMLwhich requires Single-UpdateMode and it cannot enter this state due the fact that there is an
active process on the server. the import will enter a ‘wait’ state and will enter ‘Single-UpdateMode’ when there are
no active processes on the server.

If the XML being loaded is not set to go in to Single-UpdateModewhen imported the processwill highlight it is
required to go into Single-UpdateMode but was not successful.

Configurations for Exporting the Data
When doing the first export where you select the configurations you require to be exported, it is advisable to save a
configuration file. As there are a number of configurations, you couldmiss a vital configuration if a user manually
sets this each time they do a configuration export.

l Scenario 1 - In this scenario we need to identify what is different between our source and target systems and
update the target with the necessary updates.

Checking what is different between system to generate STEPXML to update target system :

l Back-up target system
l Export XML fromSource system excluding Assets, Classifications, Entities and Products
l Run aCrossContext export if configuration is stored inmore dimension points i.e., LOVs, attribute names
etc.

l Export XML fromTarget system as above
l The compare tool will highlight what is on the Source system only and what is different
l Generate STEPXML tool
l Load into target system
l Check execution report for errors and resolve
l Use compare tool to see what is different or only on the target system to remove or update

l Scenario 2 - In this scenario we need to identify what only exists on the target systemwhich will have to be
manually removed or updated.

Removing configuration from a target system :
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l Back-up target system
l Export XML fromSource system excluding Assets, Classifications, Entities and Products
l Export XML fromTarget system as above
l The compare tool will highlight what is on the Target system only
l STEP user will need tomanually remove the specific configurations from the target system

l Scenario 3 - In this scenario we need to compare the system only.

Compare configurations to see if the source and target systemsmatch each other:

l Export XML fromSource system excluding Assets, Classifications, Entities and Products
l Run aCrossContext export if configuration is stored inmore dimension points i.e., LOVs, attribute names
etc

l Export XML fromTarget system as above
l The compare tool will highlight what is not identical

l Scenario 4 - In this scenario, use the compare tool to generate XML for specific object types. For example, to
move two product types from source system to the target, choose to compare the same file and decide the
objects to generate XML for.

Generating valid STEPXML:

l Export XML fromSource system excluding Assets, Classifications, Entities and Products
l Run aCrossContext export if configuration is stored inmore dimension points i.e., LOVs, attribute names
etc

l Re-use the source XML in the target
l The compare tool will highlight what is identical and you can choose to view the XML via the hyperlinks for
the appropriate objects

Considerations for STEPXML Imports
When using the STEPXMLComparison Tool, review the following considerations.

Single-Update Mode

l Configuration updates can require STEP to go into ‘Single-UpdateMode’. The updates that require Single-
UpdateMode via the comparison tool are listed theSTEPXML Comparison Tool Limitations section

l Change attribute to / from being free text searchable - Yes
l Change attribute to / from beingmulti valued - Yes
l Activate / Deactivate unique keys - Yes but only the configuration
l Change reference type to / from beingmulti valued
l Modify or Move classification-product link types
(e.g., move from one type to another type)

l Change classification-product link type to / from beingmulti valued
l Remove child object type in product, classification, entity, or publication object type hierarchy

Removing valid object types from an attribute
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Issues that can occur when removing validity:

l Remove object types as being valid for an attribute are not allowed when data exists for applicable products.
A warning is included in the execution report.

l Usersmust manually insert the XML tagOnlyAllowValidUserTypes=’true’ in the STEP-ProductInformation
tag.

l Attribute changes from Text to Number validationmay not be allowed if there is data within the system for
products that do not conform to Number validation.

Preparation required in target system for a successful import

Issues that could occur during STEPXML import:

l New users cannot be created by the import since a password is required.

l Event queues and consumers are created with a disabled status in the target system.

l If the configuration being loaded relies on an object that does not exist within STEP awarning is displayed in
the execution report. Required nodesmust exist to receive data being loaded.

For example:

l Valid object typesmust exist when loading attributes
l Dimension pointsmust exist when loading linked contexts
l Referenced objectsmust exist when loading privilege rules
l Referenced user groupsmust exist when loading Stateflows
l Classification nodesmust exist to hold bulk update configurations, export configurations, import
configurations, transformation lookup tables, andWebUI configurations

l Collectionsmust exist for product selections based on collections
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STEPXML Comparison Tool Limitations
The comparison tool can be used to create STEPXML tomodify and add relevant configuration. It will not delete or
modify configuration that is already in use within STEP. It will also not make updates that require user input.

Listed below are the configurationswithin STEP that cannot be updated using this tool:

l Cannot change a list of value unless it has a non auto-generated ID
l If attributes have beenmerging on the source system the redundant attribute on the target systemwill need
to bemanually removed

l If List of values have beenmerged on the source system these redundant valueswill need to be removed /
merged on the target system

l Swapping attribute ids
l Cannot change an attribute from internal to externallymaintained as this requires user input –i.e., where to
take the values fromMain / Approved workspace

l Cannot remove dimension dependencies as this requires user input to determine which values to keep after
removing the dependency

l RemoveWorkspaces –manual task
l Cannot change an attribute to have LOV validation or not to use LOV validation
l Cannot change reference types to / from being externallymaintained as this requires user input
l Cannot change classification-product link type to / from being externallymaintained as this requires user
input

l Cannot change "OwnsProduct Links" setting on classification object type
l Cannot change Revisability of an entity object type

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 56



Version Control System Integration
Via a set of outbound integration endpoint plugins, it is possible to configure STEP to publish the system
configuration to a branch in Git, an external Version Control System (VCS) (see:https://git-scm.com). Using
inbound integration endpoint plugins, files from aGit branch can be combined, enriched with processing
instructions, and imported on a target system as a STEPXML file.

This functionality allows for easy comparison of configurations across systems in a Development, Test,
Acceptance, and Production (DTAP) environment and ismeant to aid customerswho need to transfer
configuration changes between different systems and/or ensure systems are in sync configuration-wise.

Note: The 'configuration-management' add-on component must be activated to enable VCS.

Configuration / Data
In STEP, the distinction between configuration and data is not always clear. While most of the objects and settings
that can be found in the STEPWorkbench SystemSetup tab clearly are configuration, the Tree tab holds both
data and configuration. For example, objects like import, export, and bulk update configurations are obviously
configuration, but in addition, classification hierarchies, upper levels in the product and entity hierarchies, and
entity structures used for modeling reference data are widely regarded as configuration.

For the functionality presented in the plugin topics / sections of theVersion Control System Integration
documentation, there is no preconceived notion of what is configuration and what is data. Instead, as described in
theOutbound Endpoint Configuration topic, this can be configured. However, it should be stressed that the
functionality is not designed to handle vast amounts of data objects (e.g., SKUs).

Information about VCS Integration
Additional information can be found in the following sections / topics:

l Integration Endpoint Plugins
l Outbound Endpoint Configuration
l Inbound Endpoint Configuration
l Editable Business Rules Format
l VCS: Example Setups
l VCS: Considerations and Limitations
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Integration Endpoint Plugins
The plugin suite for VCS integrations consists of these plugins:

l Outbound Integration Endpoint 'STEPXMLSplitter' Post-processor Plugin
l Outbound Integration Endpoint 'Git Delivery' Plugin
l Inbound Integration Endpoint 'STEPXML Joiner' Pre-processor Plugin
l Inbound Integration Endpoint 'InvokeOIEP' Post-processor Plugin

Each is described in their own section below.

Additionally, within this topic, you will also find information regarding an editable business rule format. JavaScript-
based business rules can be created, maintained, and (unit) tested outside STEP. This allows customers and
partners to govern the lifecycle of business rules in a standard source code control system such asGIT, and from
there, be able to deploy appropriate versions of the business rules to the various STEP systems that are part of a
Development, Testing, Acceptance and Production (DTAP) environment.

Outbound Integration Endpoint 'STEPXML Splitter' Post-processor
Plugin
The 'STEPXMLSplitter' post-processor can take any STEPXML file produced by the 'STEP Exporter' processing
engine as input and will split the file into multiple valid STEPXML files / editable business rule format files that are
then passed to the configured delivery plugin. Generally, the splitter produces one file per STEP object and further
normalizes the content so that elements for which the sequence has no significance in STEP are output in the
same order every time. Non-object configurations (e.g., derived events) and system settings are output in a single
file.

The reasoning behind splitting and normalizing is that it makes it easier to compare configurations outside of STEP
in a VCS like Git. Further, it makes it easy to selectively choose specific configuration items to be imported on
another system.

The ‘STEPXMLSplitter’ plugin has two configuration options explained below.

Split mode
Split mode, that defaults to ‘Flattened’, with the other option being hierarchical, affects how STEP objects that
normally are exported in a nested fashion are represented in the produced split files.
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To illustrate the difference, in the example shown below, the classification hierarchy is being exported.

In bothmodes, one file will be created per classification object, but in ‘Hierarchical’ mode each of the leaf
classifications, like e.g., 'Import Configurations', will be nested inside the element representing the 'Configurations'
classification (this element will be stripped of all but ID, object type ID, and parent ID information) as shown below.

(…)
<Classifications>

<Classification ID=‘ConfigurationsRoot’ UserTypeID=‘ConfigurationsRoot’
ParentID=‘Classification 1 root’>

<Classification ID=‘stibo.IMConfigFolder’
UserTypeID=‘ImportConfigurationsRoot’>

<Name>Import Configurations</Name>
<MetaData>

<Value AttributeID=‘Purpose’ QualifierID=‘en-US’>Storage for
import configurations</Value>

</MetaData>
</Classification>

</Classification>
</Classifications>
(…)

In 'Flattened' mode, upper levels will be omitted, and each file will contain exactly one 'Classification' element with
parent identifier information as shown below.
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(…)
<Classifications>

<Classification ID=‘stibo.IMConfigFolder’
UserTypeID=‘ImportConfigurationsRoot’ ParentID=‘ConfigurationsRoot’>

<Name>Import Configurations</Name>
<MetaData>

<Value AttributeID=‘Purpose’ QualifierID=‘en-US’>Storage for import
configurations</Value>

</MetaData>
</Classification>

</Classifications>
(…)

Generally, it is recommended to use the default 'Flattened' mode while the 'Hierarchical' mode only should be
used if the full hierarchy pathmust be present in each file. Obviously, the 'Hierarchical' example from above can be
imported on a systemwhere the classification with ID 'ConfigurationsRoot' is not present (it will be created during
import). Importing the 'Flattened' example on such a systemwill, on the other hand, result in an error.

Convert business rules to editable format
This option determines how business rules (conditions, actions, functions and libraries) are exported. If set to ‘No’,
the business rules are exported as STEPXML files. If set to ‘Yes’, the rules are exported in the editable *.js format
described in this topic.

When exporting editable business rules, the parameter 'Convert business rules to editable format' option should
be set to 'Yes.' The business rules in the STEPXML that are fed to the post-processor will be converted to the
editable format and represented in a single *.js file instead of being represented in a STEPXML file. For details,
see theEditable Business Rules Format topic.

Outbound Integration Endpoint ‘Git Delivery’ Plugin
The 'Git Delivery' plugin delivers files produced by the outbound integration endpoint processing engine / a
configured post-processor to a branch in a remote Git repository (see https://git-scm.com for more information
about Git). When using the plugin on an on-premise STEP system, the delivery to Git can be performed via a
configured local directory accessible from all application servers in the cluster (see the 'Local git repository URI'
section below). With this setup, the plugin first checks if the local delivery directory is Git enabled. If this is the case,
the following operations are performed:

1. Git fetch
2. Git checkout (of configured branch)
3. Git hard reset
4. Git pull (if branch exists in remote)

If the local directory is not Git enabled, the following operations are performed:

1. Git clone
2. Git checkout (of configured branch)
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On cloud-based STEP systems, a temporary local directory will always be used and the second approach with
clone and checkout will be used.

Note: The remote repository cannot be empty. At least one branch with one file must exist.

After this, the locally checked-out branch will be in syncwith the remote branch, and the following operations are
performed:

1. Files produced by the outbound integration endpoint are written to the local directory
2. Files in local directory but not in delivery are deleted
3. Git stage
4. Git commit
5. Git push

If the configured branch does not exist in the remote repository in advance, it will be created.

It is important to understand the implications of this functionality, namely that:

l The outbound integration endpoint must with each invocation produce files for all the configuration objects /
settings to be represented in the configuredGit branch. Exporting only a file for a single object will cause all
other files in the Git branch to be deleted. See theOutbound Endpoint Configuration topic for more
information on how to configure an outbound integration endpoint using this delivery plugin.

l Only STEP shouldmake changes in the configuredGit branch. All other changeswill be overwritten with the
next STEP delivery.

The 'Git Delivery' plugin has the following parameters:
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Local git repository URI
URI for the local directory via which configuration files will be synchronized. Possible values for this parameter are
read from 'GitDelivery.LocalRepoUri.[integer]' configuration property entries.

Important: The 'GitDelivery.LocalRepoUri.[integer]' property should only be set for on-premise STEP
systems. For cloud STEP systems, the property should not be set and the 'Local git repository URI' parameter
should be left blank in the plugin configuration.

Having, for example, the following entries in sharedconfig.properties:

GitDelivery.LocalRepoUri.1=/workarea/conf-attributes
GitDelivery.LocalRepoUri.2=/workarea/conf-all

will make it possible to select between the values '/workarea/conf-attributes' and '/workarea/conf-all' for the
parameter in the workbench.

Note: For this property and the onesmentioned below, the sequence of the variable integers in the property
namesmust be complete. E.g., 1, 2, 3. Property valueswill not be read correctly if the sequence is, for instance
1, 3, 4.
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Remote git repository URI
URI for the remote repository. Aswith the 'Local git repository URI' values that can be selected in the workbench
are read from 'GitDelivery.RemoteRepoUri.[integer]' configuration property entries.

Examples:

GitDelivery.RemoteRepoUri.1=https://bitbucket.org/john-smith/step-conf.git
GitDelivery.RemoteRepoUri.2=ssh://gituser@192.168.56.102/home/gituser/git/repo.git

Git branch
Name of the branch to which the delivery is published. Values for this parameter are read from
'GitDelivery.Branch.[integer]' configuration property entries. Examples:

GitDelivery.Branch.1=step-dev-1
GitDelivery.Branch.1=step-qa

Author name
Author name for the Git commit. Values for this parameter are read from 'GitDelivery.AuthorName.[integer]'
configuration property entries. Example:

GitDelivery.AuthorName.1=John Smith - STEP Dev1

Author email
Author email for the Git commit. Values for this parameter are read from 'GitDelivery.AuthorEmail.[integer]'
configuration property entries. Example:

GitDelivery.AuthorEmail.1=john.smith@gmail.com

Repository username
The remote repository username. Values for this parameter are read from 'GitDelivery. RemoteRepoUsername.
[integer]' configuration property entries. Example:

GitDelivery.RemoteRepoUsername.1=john.smith@gmail.com

Repository user password
The remote repository password. Passwordmust be entered directly when configuring the plugin.

Path to private key when using ssh
The remote repository private keywhen using Secure Shell Protocol (SSH). Values for this parameter are read
from 'GetDelivery.SshPrivateKeyURI.[integer]' configuration property entries. The folder specified should contain
the private SSH key. Example:

GitDelivery.SshPrivateKeyURI.1=/home/stibosw/.ssh/id_rsa
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Repository ssh passphrase
The remote repository Secure Shell Protocol (SSH) password / passphrase. Passphrasemust be entered directly
when configuring the plugin.

Remote Setup Example
This section contains an example of how a remote Git repository using Bitbucket (https://bitbucket.org)
(https://bitbucket.org) can be configured from scratch to work with the Git delivery plugin.

1. Create a new repository with a 'README' file via the Bitbucket web interface.

2. Create a system specific branch in the repository.
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3. Get the 'Remote git repository URI' from, for example, the Bitbucket 'Clone' option.

Inbound Integration Endpoint 'STEPXML Joiner' Pre-processor Plugin
The 'STEPXML Joiner' inbound pre-processor plugin has been designed to be used for getting configurations and
settings exported via the outbound functionality, described above, imported on a system. The outbound
functionality produces STEPXML files and potentially*.js files representing business rules. The 'STEPXML Joiner'
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plugin can take a .ZIP file containing any number of such files as input and will then combine these to a single
STEPXML file with objects and settings appearing in themost sensible order and pass the combined file to the
inbound integration endpoint processing engine.

The pre-processor plugin can add various processing instructions to the combined STEPXML file, and there are
two options for specifying these instructions. Users can either use the UI to configure the processing instructions
(see screenshot below) or users can include a template STEPXML file in the .ZIP file fed to the endpoint.

To configure the UI:

1. Make a single updatemode selection.
2. Make an import context selection. This is the context that will receive the imported data
3. For 'list properties' (multiple instances of the same XML element at the same level) such as 'Value' elements

inside the 'Values' element for a product or 'TargetUserTypeLink' elements for a reference type definition, this
means that special processing instructionsmust be used to express that properties not present in the import file
must be removed from the system as part of the import. Add these replacement instructions by clicking 'Edit
Replace Instructions'.

4. Within the 'Edit Replace Instructions' dialog, build the rules by selecting options on the left and using the arrow
tomove the rule over to the right box. Save changes beforemoving to the next step within the Inbound
Integration Endpoint Wizard.
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If a template file is provided in the .ZIP, the settings from this file overrule anyUI configurationsmade in the UI. The
template file must be named 'ProcessingInstructions.xml' and should, inside the STEP-ProductInformation
element, only include the ReplacementRules element.

For more information regarding ReplacementRules, see theReplacementRules Tag in STEPXML topic in the
STEPXML Tags and Examples section of theData Exchange documentation.

Inbound Integration Endpoint 'Invoke OIEP' Post-processor Plugin
The 'InvokeOIEP' post-processor plugin allows for an outbound integration endpoint to be invoked once the
inbound import process has completed. Thismakes it possible to update the representation of the system
configuration in a remote Git branch immediately after the configuration has been imported. As can be seen below,
the plugin only has a single configuration parameter: the ID of the outbound integration endpoint to invoke.

For more information, see these topics in theVersion Control System Integration section:

l Editable Business Rules Format
l VCS: Example Setups
l VCS: Considerations and Limitations
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Outbound Endpoint Configuration
This section describes step-by-step how an outbound integration endpoint can be configured to be used for
publishing the system configuration to a remote Git repository.

Note: If you want to compare the configurations frommultiple systems, the endpoint configuration on the
systems should be identical (except for the Git branch 'Git Delivery' plugin information).

1. Launch the 'Outbound Integration Endpoint Wizard' by selecting 'Create Outbound Integration Endpoint…' in
the context menu for a setup group configured to hold outbound integration endpoints.

2. In the 'Identify Endpoint' step of the wizard, enter basic information. Make sure the endpoint is configured to run
as a system user who has view privileges to the configuration objects to be exported.

3. As stated in Integration Endpoint Plugins > Outbound Integration Endpoint 'Git Delivery' Plugin , all
configurations and settings to be held in Git must be published each time the outbound integration endpoint is
invoked. Therefore, the endpoint must in step 2 of the wizard be configured to use the 'Select Objects' data
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source option.Even if no product, entity or classification objects are to be published, a 'dummy'
selection must be made. If such data objects are to be published, the relevant root nodes should be selected.

4. In the 'Configure Endpoint' step, select 'STEP Exporter' as the processing engine. As for the 'Workspace'
parameter, most configuration objects are not workspace revised; if data objects like products, entities and
classifications are to be published, in most cases it is the approved version of these objects that should be
exported and for this, the 'Approved' workspace should be selected. If configuration data that is to be published
is dimension dependent, all relevant contexts should be selected.

5. Once the wizard has been completed, on the 'Configuration' tab of the newly created endpoint, configure the
schedule, queue, and process retention settings as desired.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 69



6. In the 'Output Templates' section, add a single configuration and select the object types of the nodes selected
for publishing (must also be done for 'dummy' selections).

Note: TheGit delivery plugin will only work with a single output template.
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7. For 'Format', the Version Control System (VCS) integration plugins will work with either the 'STEPXML' or the
'Advanced STEPXML' format plugins. However, if data objects are to be published and the exported objects
are to be filtered according to their object types, the 'Advanced STEPXML' optionmust be selected.

If 'STEPXML' is selected, select 'Yes' / 'All' for the configuration types to export, 'Minimum' for products,
entities, and classifications, if these are to be exported and 'No' / 'None' for all types that should not be
published.
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Further, to make obfuscated configurations (e.g., business rules) comparable outside STEP, select 'Yes' to export
'Definitions AsComments'.

If the 'Advanced STEPXML' option is selected, enter the appropriate template andmake sure to set the STEP-
ProductInformattion 'DefinitionsAsComments' attribute to 'true'.
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Full example configuration with product object type filtering is shown below:

<?xml version='1.0'?>
<STEP-ProductInformation DefinitionsAsComments='true'>

<TagGroupList/>
<TagList/>
<Qualifiers/>
<GlobalSettings/>
<UserTypes ExportSize='All'/>
<Keys/>
<DerivedEventTypes/>
<EdgeTypes/>
<CrossReferenceTypes ExportSize='All'/>
<DimensionList/>
<ContextList/>
<UnitList ExportSize='All'/>
<CollectionList ExportSize='All'/>
<ListOfValuesGroupList/>
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<ListsOfValues ExportSize='All'/>
<IntegrationEndpoints/>
<EventProcessors/>
<SetupGroups/>
<SetupEntities/>
<AttributeGroupList ExportSize='All'/>
<AttributeList ExportSize='All'/>
<DataContainerTypes ExportSize='All'/>
<ActionSetList/>
<UserGroupList/>
<UserList/>
<SystemSetup ExportSize='All'/>
<TableColors ExportSize='All'/>
<TableRules ExportSize='All'/>
<TableTypeGroupList ExportSize='All'/>
<TableTypeDefinitions ExportSize='All'/>
<ECatalogs/>
<EventQueues/>
<STEPWorkflows ExportSize='All'/>
<BusinessLibraries ExportSize='All'/>
<BusinessRules ExportSize='All'/>
<MatchCodes/>
<MatchingAlgorithms/>
<PortalConfigurations ExportSize='All'/>
<AttributeTransformationGroups/>
<ImportConfigurations ExportSize='All'/>
<ExportConfigurations ExportSize='All'/>
<BulkUpdateConfigurations ExportSize='All'/>
<TransformationLookupTableConfigurations ExportSize='All'/>
<ComponentModels/>
<Products ExportSize='Minimum'>

<FilterUserType ID='Level1'/>
<FilterUserType ID='Level2'/>
<FilterUserType ID='Level3'/>
<Product/>

</Products>
<Classifications ExportSize='Minimum'/>

</STEP-ProductInformation>

8. Configure the 'STEPXMLSplitter' post-processor. For more information, see Integration Endpoint Plugins
> Outbound Integration Endpoint 'STEPXML Splitter' Post-processor Plugin for details.
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9. Configure the 'Git Delivery' delivery plugin. See section Integration Endpoint Plugins > Outbound
Integration Endpoint 'Git Delivery' Plugin for details.
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Inbound Endpoint Configuration
The inbound 'STEPXML Joiner' pre-processor plugin and the 'InvokeOIEP' post-processor plugin are configured
via the 'Inbound Integration Endpoint Wizard' opened by selecting 'Create Inbound Integration Endpoint…' in the
context menu for a setup group configured to hold inbound integration endpoints. For details, see the Inbound
Integration Endpoint 'STEPXML Joiner' Pre-processor Plugin and the Inbound Integration Endpoint
'Invoke OIEP' Post-processor Plugin sections of the Integration Endpoint Plugins topic.

The endpoint must be configured to import STEPXML (provide any valid STEPXML file as a sample file) and can
be configured with any receiver plugin capable of handling .ZIP files, for example, the 'Hotfolder Receiver' or the
'REST Receiver'. If workspace revisable objects like products and classifications are imported, it must be decided
whether or not import changes automatically should be approved.

Example configuration shown below:
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Editable Business Rules Format
JavaScript-based business rules can be created, maintained, and tested outside STEP. This allows customers
and partners to govern the lifecycle of business rules in a standard source code control system such asGit, and
from there, be able to deploy appropriate versions of the business rules to the various STEP systems that are part
of a Development, Testing, Acceptance and Production (DTAP) environment.

This topic describes the following in detail:

l Editable BusinessRule Format
l Options for Export
l Options for Import
l REST Resources for Testing and Validation

Note: The 'configuration-management' add-on component must be activated to enable the functionality
described below.

Business rules can be exported as *.js files that can be edited outside STEP and imported back into a STEP
system, creating or updating a business rule. This format is available for business conditions, actions, functions,
and libraries of 'Global' scope created using the business rule format introduced with STEP 7.0. Each file
represents a single business rule and contains all information necessary to create / update the rule on import.

In the *.js files, metadata and definitions of non-JavaScript operations and preconditions ('Applies if') is output in
comment sections, while the JavaScript for the individual operations and preconditions are wrapped in functions
with objects provided by the execution context as parameters (binds, messages, function input parameters, and
referenced libraries).

Example: Assume there is a simple business action with one JavaScript operation and a non-JavaScript
precondition as shown below:
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When exported using the default settings, the business action will be represented as follows in the generated file:

/*===== export metadata =====

{

"contextId" : "Context1",

"workspaceId" : "Main"

}

*/

/*===== business rule definition =====

{

"id" : "CreateReference",

"type" : "BusinessAction",
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"setupGroups" : [ "Actions" ],

"name" : "Create Reference",

"description" : null,

"scope" : "Global",

"validObjectTypes" : [ "SalesItem" ],

"allObjectTypesValid" : false,

"runPrivileged" : false,

"onApprove" : "Never",

"dependencies" : [ ]

}

*/

/*===== business rule plugin definition =====

{

"pluginId" : "JavaScriptBusinessActionWithBinds",

"binds" : [ {

"contract" : "CurrentObjectBindContract",

"alias" : "node",

"parameterClass" : "null",

"value" : null,

"description" : null

}, {

"contract" : "ReferenceTypeBindContract",

"alias" : "refType",

"parameterClass" : "com.stibo.core.domain.impl.ReferenceTypeImpl",

"value" : "PrimaryProductImage",

"description" : null

}, {

"contract" : "AssetBindContract",

"alias" : "asset",

"parameterClass" : "com.stibo.core.domain.impl.FrontAssetImpl$$Generated$$7",

"value" : "P_AC-AXPFX769",

"description" : null

} ],

"messages" : [ {

"variable" : "AssetNotFoundError",

"message" : "Asset with ID \"P_AC-AXPFX769\" could not be found",

"translations" : [ ]

} ],

"pluginType" : "Operation"

}

*/

exports.operation1 = function (node, refType, asset, AssetNotFoundError) {

if (asset == null) {
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throw new AssetNotFoundError();

}

if (node.getReferences(refType).isEmpty()) {

node.createReference(asset, refType);

}

}

/*===== business rule plugin definition =====

{

"pluginId" : "ValidHierarchiesBusinessCondition",

"parameters" : [ {

"id" : "HierarchyRoots",

"type" : "java.util.List",

"values" : [ "step://product?id=I-Level1-1" ]

} ],

"pluginType" : "Precondition"

}

*/

Asmentioned above, the logic of the JavaScript operation is wrapped in a function. This function is, in the
example, exported in line with the Node.jsmodule system convention. A configuration property
'ConfigurationManagement.BusinessRuleConverter.ExportFormat' can be used to change this. The possible
values of this property can be 'NodeExport' (default; Node.jsmodule system), 'EcmaScriptExport' (ECMAScript
module system compliant format), and 'NoExport' (functions not exported).

The format for business libraries differs somewhat as a library in STEP already holds a number of JavaScript
functions that can be called from other business rules. Tomake these functions available to other modules, the
functions are exported when the 'NodeExport' or 'EcmaScriptExport' settings are used.

Example: Assume a library has the following content:

function isProductBelow(prod, checkProdID) {

if(!isProduct(prod)) throw "Function only works with Products";

if(checkProdID == "Product hierarchy root") return true;

if(prod.getID() == "Product hierarchy root") throw "The top level Product is never

below another Product.";

var currentParentId;

var currentProd = prod;

while (true) {

currentParentId = currentProd.getParent().getID();

if(currentParentId == "Product hierarchy root") return false;

else if (currentParentId == checkProdID) return true;

else currentProd = currentProd.getParent();

}

}
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function isProduct(obj) {

return obj instanceof com.stibo.core.domain.Product;

}

When exported with 'ConfigurationManagement.BusinessRuleConverter.ExportFormat' set to the default
'NodeExport' value, the following is appended to the file making it possible to require / import the functions from
another Node.jsmodule. Notice that, as stated in the comment, everything below and including the comment will
be ignored when the library file is imported in STEP.

/*===== business library exports - this part will not be imported to STEP =====*/

exports.isProductBelow = isProductBelow

exports.isProduct = isProduct

Important:While it is possible in STEP to call functions in other business libraries fromwithin a library
function, this functionality is not supported when calling the exported library functions from another module.

To have library functions that call functions in other referenced libraries be executable outside STEP, these can be
modified so that it is possible to pass the library as a parameter. For example, assume that there is a library
function like the one that follows:

//"lib" is alias for a referenced library with a function getUpc()

function setUpc(node, attributeId) {

node.getValue(attributeId).setSimpleValue(lib.getUpc());

}

This function could bemodified as shown below, making it possible to pass the library as a parameter when
invoking the function outside STEP.

function setUpc(node, attributeId, passedLib) {

if (lib == null) {

lib = passedLib;

}

node.getValue(attributeId).setSimpleValue(lib.getUpc());

Note: Adding an extra optional parameter will not require that the JavaScript calling the function bemodified.

Options for Export
Business rules can be exported to the editable format in two different ways:

Manual export
Tomanually export business rules individually, use the 'Export in Editable Format' context menu option for
business rules as shown below:
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Outbound Integration Endpoint
When using the configurationmanagement 'STEPXMLSplitter' post-processor plugin for outbound integration
endpoints, the parameter 'Convert business rules to editable format' option (shown in the next image) will be used.

When this option is selected, any business rule in the STEPXML that is fed to the postprocessor will be converted
to the editable format and represented in a single *.js file instead of being represented in a STEPXML file.

For details, see theOutbound Integration Endpoint 'STEPXML Splitter' Post-processor Plugin sections of
the Integration Endpoint Plugins topic.

Options for Import
Import-wise there are also two options:

Manual import

To import a single business rule manually, use the File > Import > Import BusinessRule fromEditable Format
menu option as shown below.
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Inbound Integration Endpoint
For importingmultiple business rules via an inbound integration endpoint, the configurationmanagement
'STEPXML Joiner' preprocessor can be used. The preprocesser accepts a .ZIP file containing STEPXML files as
input aswell as business rule *.js files that the preprocessor will convert to STEPXML andmerge into the
STEPXML file delivered to the import part of the processing.

For details, see the Inbound Integration Endpoint 'STEPXML Joiner' Pre-processor Plugin section of the
Integration Endpoint Plugins topic.

REST Resources for Testing and Validation
TwoREST resource operations are available:

l One for testing JavaScript on a running STEP server.
l One for validating the syntax of a business rule in the editable format on a STEP server.

The REST resource for testing JavaScript is available at http(s)://[step-hostname]:[step-port]/configuration-
management/test-javascript?context=[context-id]&workspace=[workspace-id] and lets clients execute
ECMAScript 5 compliant JavaScript on a running STEP server in a non-committingmodewith access to a STEP
Manager that again gives access to the standard STEP Scripting API.

As an example, POSTing the function shown below to https://[step server]/configuration-management/test-
javascript?context=Context1&workspace=Main would return "Context1":

function getContextId(manager) {

return manager.getCurrentContext().getID();

}

getContextId(manager);

The resource for validating a business rule definition in the editable format is available at http(s)://[step-hostname]:
[step-port]/configuration-management/validate-business-rule. The resource lets clients POST a complete
business rule definition and will validate the business rule in three steps:

1. Model validation - validates the overall structure and determines if the business rule metadata is correct
(syntax check only).
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2. Domain validation - validates existence of the operation and precondition plugin and checks to see if the
correct parameters have been supplied (values are not checked).

3. Conversion validation - validates if the business rule definition can successfully be converted to STEPXML.

The resource returns a boolean indicating whether or not the business rule is valid and includes a list of errors, if
anywere encountered.

Example response:

{

"valid": false,

"errors": [

"'businessRuleDefinition.id': may not be null"

]

}

Both REST resources use basic authentication and the user invoking the resourcesmust have a privilege that
includes the 'Test JavaScript' setup action. Further, the configuration property
'ConfigurationManagement.TestJavascript.Enabled' must be set to 'true' on systems to be used for tests and
validation (defaults to 'false').

Note: There is an example step.js Node.jsmodule that wraps the REST resources available from the
STEP API Documentation page that can be used together with the documentation and examples provided.

Additional VCS information can be found in the following sections / topics:

l Outbound Endpoint Configuration
l Inbound Endpoint Configuration
l VCS: Example Setups
l VCS: Considerations and Limitations
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VCS: Example Setups
The plugins described in the Integration Endpoint Plugins topic can be used in several different scenarios and
do not necessarily have to be used together. This section describes two different possible setups.

System Comparison
It is possible to use just the outbound integration endpoint plugins to have the configuration from each system in a
DTAP environment published to different branches in a remote Git repository allowing for easy (manual)
comparison of configurations using the 'diff' tools Git offers.

Systems can publish their configurationswith scheduled intervals or on demand either via workbench or by
invoking the outbound integration endpoints remotely via REST (resource operation available in the STEP REST
API V1).
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Such a setup can be used to ensure systems are in sync or only have expected differences. If differences are
found, STEPXML files held in the Git branches canmanually be imported one by one on a system that needs to be
updated, or alternately, multiple files can be zipped and supplied to an inbound integration endpoint configured to
use the 'STEPXML Joiner' pre-processor described in Integration Endpoint Plugins > Inbound Integration
Endpoint 'STEPXML Joiner' Pre-processor Plugin.

Note: The VCS integration functionality offers no automatic dependency handlingmeaning that it is the
responsibility of the user transferring files to ensure that all files necessary to create / update configuration
objects are included and, given that the 'STEPXML Joiner' pre-processor is not used, that files are imported in
the correct order.

A tool like Jenkins https://jenkins.io/https://jenkins.io/ could, with this setup, be used tomonitor the branches for
changes.With amonitoring tool, diff reports can be sent to users via mail.

Branch comparisons can bemade using theGit command line tool (see, for example, https://git-scm.com/docs/git-
diffhttps://git-scm.com/docs/git-diff), or if a tool like Bitbucket is used, via a web interface as shown below.
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Semi-automated System Synchronization
With a tool like Jenkins configured tomonitor branches for changes, instead of just sending diff reports to users, a
Jenkins job could be used to automatically keep systems in sync. The diagram below illustrates a setup where
changes on STEP system 'SYS A' automatically are deployed on another STEP system 'SYS B'.
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For this to work, a Jenkins jobmust monitor the 'SYS A' branch for changes, and when such changes are
identified, compare the branch with the 'SYS B' branch, produce a .ZIP file containing files from the 'SYS A'
branch that differ, and then pass the .ZIP file to an inbound integration endpoint on 'SYS B' configured to use the
'STEPXML Joiner' and 'InvokeOIEP' plugins.

Example Jenkins job 'Build' shell script ($gituser, $gitpassword and $sysbpassword, $sysbuser defined via
'Username and password (separated)' bindings):

#!/bin/bash
timestamp=$(date +%s)
gitserver='bitbucket.org/john-smith/step-conf.git'

sysbstepserver='sys-b.domain.com'
hotfolder='/upload/hotfolders/ConfigurationManagement/in'

git clone https://$gituser:$gitpassword@$gitserver checkout_$timestamp
cd checkout_$timestamp
git checkout $sys-b
git checkout $sys-a
git pull
git diff -z $sys-b..sys-a --name-only --diff-filter=ACMRT | xargs -0 zip
cpg_diff_$timestamp.zip
sshpass -p $sysbuserpassword scp cpg_diff_$timestamp.zip
$sysbuser@$sysbstepserver:$hotfolder
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The Jenkins job could further, via REST, invoke the inbound integration endpoint on 'SYS B' andmonitor the
import process, notifying human users if errors should occur. Alternately, the inbound integration endpoint could
be scheduled to run frequently, and an error reporter plugin could be used to notify users about errors.

For a setup like this, it is important to be aware that the 'STEP Importer' processing engine cannot handle all
updates. See theVCS: Considerations and Limitations topic for more information.
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VCS: Considerations and Limitations
The Version Control System (VCS) integration functionality is only limited per standard STEP functionality,
meaning that not all configurations can be exported / expressed in STEPXML, and not all changes can be applied
via the STEP Importer processing engine. The functionality works for settings stored in the STEP database rather
than files in the application server file system.

Known configurations / settings that cannot be exported / expressed in STEPXML:

l WebUI user configurable views
l WebUI user defined searches
l WebUI custom icons
l Scheduled background processes
l Workbench bookmarks

Known import limitations:

l Deletions can only be performed for products, entities, classifications, and assets. STEPXML for deleting
such objects in a target systemwould, with the current solution, have to be produced by a configured Jenkins
job, or a job in a similar tool, upon identifying objects present in the target system not present in the source
system.

l A number of update operations for configuration objects cannot be carried out if there is data in the system
conflicting with the change.

l A number of updates require single updatemode.
l Workflow definitions can, in some cases, not be updated if there are tasks for objects in the flow.
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Maintaining Partial Data Sets on Lower Level DTAP
Environments
This section explains how you can keep Dev / QA / Sandbox systems up-to-date since these systems typically
need all of the SystemSetup but only a small representative subset of the data from your production environment.
Since you only transfer a subset of the data, this will make it much faster and easier to keep these systems up to
date and also reduce the hardware requirements for these systems.

For such cases, Oracle Data Pump exports and imports cannot be used as it is not possible, with this technology,
to do such things as only export certain hierarchies or data from certain STEP contexts. Further, Oracle Data
Pump imports will overwrite any data created or modified in the target environment, which is often not desirable.
Instead, the recommendation is to use STEPXML for transferring the data.

STEPXML Export Basics
STEPXML can be exported from a STEP system via the Export Manager using either the 'STEPXML' or the
'Advanced STEPXML' format plugin. Both options produce the same format but differ in how you configure the
export, i.e., how you decide what data should be included in the exported file. The Advanced STEPXML format
pluginmakes use of an XML 'output template' sometimes also referred to as a 'recorder file' while the STEPXML
format plugin allows for the export to be configured via a UI with a large number of drop-downmenuswith the
selections that allow for behind-the-scenesmapping to an output template. The Advanced STEPXML option is
generally harder to work with but offers greater flexibility in configuring the export.

Export Manager examples shown below: STEPXML and Advanced STEPXML
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Regardless of which STEPXML format plugin is used, a key concept to understand when exporting STEPXML is
'export size.' When exporting data, it is typically not feasible to individually select all the objects that should be
exported. Instead, a few objects are selected and the export size then determineswhich objects should be
included in addition to the selected objects.

With the STEPXML format plugin, the export size is specified per super type via a dropdown as shown below:
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With Advanced STEPXML, the export size is set via a super type-specific attribute as shown below:

<Products ExportSize="Minimum">

<Product IncludeParent="true"/>

</Products>

The export sizes relevant in this context are described below.

Export Size: Selected
The ‘Selected’ export size, as the name suggests, indicates to the system that the data for the objects selected is to
be included in the export.

When using the STEPXML format plugin and selecting the option for products, classifications, and entities,
additional objects will be included. Namely, all descendants of the selected object, and for classifications, all
classification objects above the selected ones in the hierarchy. This is because choosing ‘Selected’ for products,
classifications, and entities causes the output template shown below to be used for the export. For classifications,
this template specifies that ancestors should be included (IncludeParent="true"), and since no detailed
specification is given for the ‘Classification’ element (no nested elements specifying exactly what should be
exported for a classification), descendants are also included. For products and entities, the presence of ‘Product’
and ‘Entity’ elements inside the outer ‘Product’ and ‘Entity’ elements similarly causes descendants to be included
in the export.

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ResolveInlineRefs="true">

<Classifications ExportSize="Selected">

<Classification IncludeParent="true"/>

</Classifications>

<Products ExportSize="Selected">

<Product>

<Name/>

<AttributeLink/>

<DataContainerTypeLink/>

<ClassificationReference/>

<Product/>

<ProductCrossReference/>

<AssetCrossReference/>

<EntityCrossReference/>

<ClassificationCrossReference/>

<Values/>

<OverrideSubProduct/>

</Product>
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</Products>

<Entities ExportSize="Selected">

<Entity>

<Name/>

<AttributeLink/>

<ClassificationCrossReference/>

<Entity/>

<ProductCrossReference/>

<AssetCrossReference/>

<EntityCrossReference/>

<ContextCrossReference/>

<Values/>

</Entity>

</Entities>

</STEP-ProductInformation>

Export Size: All
The ‘All’ export size is straightforward in that it disregards the export selection and indicates to the system that all
objects of a given super type are to be included in the export.

Export Size: Minimum
When focusing on a single super type (like products), the ‘Minimum’ export size works similarly to ‘Selected’ in that
it indicates that the selected objects are to be exported, and dependent on the output template, includes
descendants and ancestors.

For instance, with the example product hierarchy shown below, if P2 is selected for export and the export size
‘Minimum’ is used for products with the default output template, the exported file will contain data for P2, P3, P4,
P5, and P6.
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The difference between ‘Selected’ and ‘Minimum’ is that the ‘Minimum’ option works across super types. Assume
you are working from a product hierarchy like the one above, but this time the selected product P2 is linked into a
classification (C2) and further has a reference to an asset (A1) while the descendant product P4 is linked into the
classification C5.

Running an export with just P2 selected and the ‘Minimum’ option specified only for products will cause the same
product objects to be exported as in the example above. However, if ‘Minimum’ is also specified for classifications
and assets and the default output template is used, the export will include asset A1 and classificationsC1, C2, and
C5, aswell as the products. To summarize: the objects directly referenced / linked from the selection and its
descendants will be included. In addition, the default template for classifications specifies that ancestors should be
included; therefore, C1 is also included. The template is not applied recursively for non-selected objects when it
comes to descendants, so C3 is not exported.

The ‘Minimum’ option can also be used to include configuration objects used by exported data in the exported file.
As an example, the output template shown below will cause attributes, attribute groups, units, and lists of values
(LOVs) relevant for the product selection to be included in the exported file.

<?xml version='1.0'?>

<STEP-ProductInformation>

<AttributeList ExportSize="Minimum"/>

<AttributeGroupList ExportSize='Minimum'/>

<UnitList ExportSize='Minimum'/>

<ListsOfValues ExportSize='Minimum'/>

<Assets ExportSize="Minimum"/>

<Classifications ExportSize="Minimum"/>

<Products ExportSize="Minimum"/>

</STEP-ProductInformation>
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To bemore precise, if an export is run with P2 (from the example above) as the selection and the output template
is used, in addition to data objects, the following configuration objects will be exported:

l All attributes used on the exported data objects
l All units used by the exported attributes
l All attribute groups that exported attributes are present in (and by default, all attribute groups up to the
‘Attribute group root’)

l All LOVs used by exported attributes

Note: The logic for including configuration objects is applied recursively. For instance, you will get definitions
exported for attributes that are used for metadata on other configuration objects.

Export Size: Referenced
The ‘Referenced’ option is similar to ‘Minimum,’ but the option further prompts objects referenced from the
selection or descendants to be exported.

Consider the following setup where the selection only contains product P2, which has a reference to product P8:

With this data, an export with the following output template:

<?xml version = "1.0" encoding = "utf-8"?>

<STEP-ProductInformation ResolveInlineRefs="true">

<Assets ExportSize="Minimum"/>
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<Classifications ExportSize="Minimum"/>

<Products ExportSize="Referenced"/>

</STEP-ProductInformation>

…will produce the following objects in the export:

Products: P2, P3, P4, P5, P6, P8

Classifications: C2, C5

Assets: A1

To illustrate, in the diagram below, nodes that are not exported have been dimmed:

Notice again that the logic is not applied recursively. I.e., the classification C7 that P8 is linked into and the asset
A2 that the product references are not included in the export. Also P9, which is a child of P8, is not included.

Including Ancestors
Reusing the last data example, it will not be possible to import files exported with the settings described above
without errors on a system that does not have ancestors like P1, P7, C1 and C4 existing in the system in advance.
However, when using the Advanced STEPXML format plugin, it is possible to specify that the exporter should
include ancestor objects up to the hierarchy roots (‘PHR’ and ‘CHR’ in the diagrams).
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For products, classifications, and entities, this is done using the ‘IncludeParent’ attribute as shown in the output
template example below:
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<?xml version='1.0'?>

<STEP-ProductInformation>

<Assets ExportSize="Minimum">

<Asset/>

</Assets>

<Classifications ExportSize="Minimum">

<Classification IncludeParent="true"/>

</Classifications>

<Products ExportSize="Referenced">

<Product IncludeParent="true"/>

</Products>

</STEP-ProductInformation>

With this output template, P1, P7, C1, and C4 and all ancestor nodes up to ‘Product hierarchy root’ (‘PHR’ in the
diagram) and ‘Classification 1 root’ (‘CHR’ in the diagram), that both always exist on a STEP system, will be
included in the exported file. Thismakes it possible to import the file on a systemwhere the ancestor nodes do not
exist in advance. This is illustrated below with non-exported nodes dimmed:

From release 9.2, a similar attribute called ‘IncludeParentClassifications’ exists for assets. Setting this attribute to
‘true’ in an output template for the ‘Asset’ element will, when using the domain exporter (automatically enabled for
In-Memory systems), cause classifications that a selected or referenced asset is linked into to be included in the
exported file. For example, using the hierarchy above, C4 and all ancestor classifications up to CHR will be
included.
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Asset Content
Asset content, i.e., the actual image and document files referenced from asset objects, is not represented in
STEPXML per default. It is, however, possible to get the data included both when using the STEPXML and
Advanced STEPXML format plugins. FromSTEP version 9.2, it is also possible to import the data again, creating
or updating asset content.

With the STEPXML format plugin, asset content can be included in the exported file as shown below:

With Advanced STEPXML, binary data can be included via the ‘AssetContent’ element as shown below:

<?xml version='1.0'?>

<STEP-ProductInformation>

<Assets ExportSize="Minimum">

<Asset>

<AssetContent ExportType="Binary">

<ImageConversionConfiguration ID="Source"/>

</AssetContent>

<!-- other asset specific instructions omitted ->

</Asset>

</Assets>

<!-- other instructions omitted ->

</STEP-ProductInformation>

Notice that, with Advanced STEPXML, once you start specifying sub elements for the super type specific
elements like ‘Asset’ and ‘Product,’ you only get the data you have specified exported. For example, with the
template above, you would not get asset names or values out.

To get name, values, references and classification links exported, the template for assets should look as follows:

<Assets ExportSize="Minimum">

<Asset>

<Name/>

<ClassificationReference/>

<EntityCrossReference/>

<Values/>

<AssetContent ExportType="Binary">

<ImageConversionConfiguration ID="Source"/>

</AssetContent>
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</Asset>

</Assets>

When exporting asset content, be aware that converted versions of the content cannot be imported – only the
unconverted source (in the exported file, data for the unconverted source will be in an ‘AssetBinaryContent’
element for which the value of the ‘ImageConversionConfiguration’ ‘ID’ attribute is blank/empty string). Also, since
including asset content can lead to very large files being created, please seriously consider if asset content is
strictly required in the systems that the data is beingmoved to.

Cross Context Exports
A STEPXML file can contain data frommultiple contexts, and while the ability to manually export data for multiple
contexts has been available for the STEPXML format plugin for a number of years, it has also beenmade
available when using the Advanced STEPXML format plugin fromSTEP version 9.2.

The context selection using the STEPXML format plugin is shown below:

The context selection using the Advanced STEPXML format plugin is shown below:

Transferring Configuration and Data Between Systems
With the STEPXML export functionality described above, it is possible to select specific category nodes and have
all descendant nodes plus referenced and linked nodes acrossmultiple contexts included in a single STEPXML
file. If Advanced STEPXML is used, it is further possible to have ancestors to the exported nodes included, thereby
allowing for the data to be imported on an empty system.
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Important: For the import to succeed, it is crucial that required configuration objects like object types,
attributes, units, etc. are either included in the file or present in the target system prior to importing the data.

If the target system is empty, it will oftenmake sense to include configuration objects in the data export file. The
most straightforward approach is to use the export size ‘All’ for all configuration objects so that all attributes, units,
object types, integration endpoints, WebUI configurations, etc. are included in the exported file.

For configuration objects like attributes, it is also possible to use the ‘Minimum’ setting to avoid getting large
amounts of attributes included that are not needed. If doing so, however, there is a high probability that attributes
that are not directly used by the exported data but required for some other functionality, e.g., a business rule or a
WebUI configuration, will bemissing.

If the target system is not empty, it will make sense to use the Version Control System (VCS) integration
functionality introduced with STEP version 9.1 tomanage the configuration. For details about this functionality,
please refer to theVersion Control System Integration section of theConfiguration Management
documentation in the STEP Online Help. In brief, the functionality allows for system configurations to be pushed to
a branch in a Git repository, therebymaking it possible to easily compare the configuration across systems. The
files present in Git will be valid STEPXML files that can be imported using the standard import manager or via
inbound integration endpoint functionality also described in the Version Control System Integration section
mentioned above.

With the desired configuration in place, data can bemoved ad-hoc using the functionality described above.

Example
This section illustrates how the export logic described can be used to export a sub section of a product hierarchy
and have classification and asset dependencies included while ensuring that the exported file can be imported on
a, data-wise, empty system.

Consider the data hierarchy shown above. For this example, the goal is to export the ‘Computer Products’
category of products. And, in the exported file, include data for:

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 103



l All products below and including ‘Computer Products’
l All product ancestors for ‘Computer Products’ up to and including ‘Primary Product Hierarchy’
l All classifications that products below ‘Computer Products’ are linked into
l The ancestors for these classifications up to and including ‘Classification 1 root’ (hidden classification hierarchy
root node)

l All assets referenced from products below ‘Computer Products’ including the binary asset content
l All classifications that these assets are placed in
l The ancestors for these classifications up to and including ‘Classification 1 root’

This goal can be achieved by selecting the ‘Computer Products’ product for export and using the following output
template:

<?xml version='1.0'?>

<STEP-ProductInformation>

<Assets ExportSize="Minimum">

<Asset IncludeParentClassifications="true">

<Name/>

<ClassificationReference/>

<EntityCrossReference/>

<Values/>

<AssetContent ExportType="Binary">

<ImageConversionConfiguration ID="Source"/>

</AssetContent>

</Asset>

</Assets>

<Classifications ExportSize="Minimum">

<Classification IncludeParent="true"/>

</Classifications>

<Products ExportSize="Selected">

<Product IncludeParent="true"/>

</Products>

</STEP-ProductInformation>

As described above, the exported file can bemade to include data frommultiple contexts by selecting the desired
context in the export manager as shown below:
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The export could further bemodified to also include product objects from other categories referenced from
products below ‘Computer Products,’ and their ancestors. This can be achieved by replacing ‘<Products
ExportSize="Selected">‘ with ‘<Products ExportSize="Referenced">‘.

Note: The objects referenced from the reference targets will not be included in the export.

For it to be possible to import the generated file, definitions of attributes, object types, units, LOVs, etc. must either
exist in the target system in advance or be included in the file. Asmentioned above, the configuration can either be
managed separately using the VCS integration functionality or the configuration objects can be included in the file
by using the export size ‘All’ for all desired types. ‘Minimum’ can potentially also be used, e.g., for attributes, but as
previouslymentioned, the safest choice is to include all.

If you want to export a subset of data as described above and include all of the SystemSetup configurations, your
output template would look similar to this one: 

<?xml version='1.0'?>

<STEP-ProductInformation>

<Assets ExportSize="Minimum">

<Asset IncludeParentClassifications="true">

<Name/>

<ClassificationReference/>

<EntityCrossReference/>

<Values/>

<AssetContent ExportType="Binary">

<ImageConversionConfiguration ID="Source"/>

</AssetContent>

</Asset>

</Assets>

<Classifications ExportSize="Minimum">

<Classification IncludeParent="true"/>

</Classifications>

<Products ExportSize="Selected">

<Product IncludeParent="true"/>

</Products>

<TagGroupList/>

<TagList/>

<Qualifiers/>

<GlobalSettings/>

<UserTypes ExportSize="All"/>

<Keys/>

<DerivedEventTypes/>

<EdgeTypes/>

<CrossReferenceTypes ExportSize="All"/>

<DimensionList/>
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<ContextList/>

<UnitList ExportSize="All"/>

<CollectionList ExportSize="All"/>

<ListOfValuesGroupList/>

<ListsOfValues ExportSize="All"/>

<IntegrationEndpoints/>

<EventProcessors/>

<SetupGroups/>

<SetupEntities/>

<AttributeGroupList ExportSize="All"/>

<AttributeList ExportSize="All"/>

<DataContainerTypes ExportSize="All"/>

<ActionSetList/>

<UserGroupList/>

<UserList/>

<SystemSetup ExportSize="All"/>

<TableColors ExportSize="All"/>

<TableRules ExportSize="All"/>

<TableTypeGroupList ExportSize="All"/>

<TableTypeDefinitions ExportSize="All"/>

<ECatalogs/>

<EventQueues/>

<STEPWorkflows ExportSize="All"/>

<StatusFlags ExportSize="All"/>

<BusinessLibraries ExportSize="All"/>

<BusinessRules ExportSize="All"/>

<MatchCodes/>

<MatchingAlgorithms/>

<PortalConfigurations ExportSize="All"/>

<AttributeTransformationGroups/>

<ImportConfigurations ExportSize="All"/>

<ExportConfigurations ExportSize="All"/>

<BulkUpdateConfigurations ExportSize="All"/>

<TransformationLookupTableConfigurations ExportSize="All"/>

<ComponentModels/>

</STEP-ProductInformation>

For reference, also see the Transferring STEP Configuration and Sample Data topic in this section of
documentation.
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Transferring STEP Configuration and Sample Data
This document describes how to transfer configuration and sample data from one STEP system (the source
system) to another (the target system).

It is assumed that the target system is either empty or, configuration-wise, closely resembles the source system.
Trying to update a target system that configuration-wise is far from the source system via STEPXML export /
import will most likely lead to numerous errors during import.

It is recommended to transfer configuration and sample data separately, and the two tasks are covered in
separate sections below.

Two template export configurations are supplied with this guide via the online help documentation: a
'Configuration-Export' export configuration for exporting the STEP configuration included in the 'Configuration-
Export.xml' file and a 'ProductDataSample-Export' export configuration for exporting sample product data
included in the 'SampleProductData-Export.xml' file (see theSample Data Export and Import section for
details on how to export Customer MDM sample data). Access documentation online access to these files.

System Configuration Export and Import
Important: The 'STEPXMLConfiguration Export' format plugin, available with 10.1-MP3 and newer systems,
significantly reduces the need for manual work when exporting the configuration from a STEP system. See the
STEPXML Configuration Export Format topic in the Data Formats section of the Data Exchange
documentation.When using this plugin, the steps described below in the sections 'Importing the
Configuration-Export Export Configuration' and 'Using the Configuration-Export Export
Configuration' can be skipped.

This section describes how to export the configuration from one STEP system to STEPXML, producing a file that
can be imported on an empty STEP system or a systemwith a very similar configuration without errors.

'Configuration,' as referenced in this document, is understood as the STEP system configuration stored in the
STEP database accessible via the workbenchSystem Setup tab, i.e., all object type definitions, attribute
definitions, business rules, workflows, etc.

A template export configuration 'Configuration-Export' is supplied with this guide in the STEPXML file
'Configuration-Export.xml,' linked in the section above.

The following sections explain how to import, modify, and use the export configuration on the system fromwhich
the configuration should be exported (source system) and how to import the produced file on the target system.

Note: Prior to exporting and importing the STEP configuration, it is important to ensure that the same STEP
software components (non-baseline components and extensions) installed on the source system are also
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installed on the target system. Additionally, the same licensesmust be enabled. Importing the configuration for
features not available in the target systemwill lead to errors during import.

Importing the Configuration-Export Export Configuration
Follow the steps below to import the Export Configuration on the source system.

1. The Export Configuration will by default be imported in the STEP Context with the ID 'Context1' (a context
existing by default in newer STEP systems). If you do not have a Context with this ID in the source system,
open the 'Configuration-Export.xml' file in a text or XML editor, change the value for the 'STEP-
ProductInformation' element 'ContextID' attribute to the ID of the Context you wish to import into and save the
changes.

All contexts in a STEP system can be seen in the Contexts editor of theSystem Setup tab in the workbench.

2. The Export Configuration will be imported below aClassification with ID 'stibo.EMConfigFolder.' This
classification exists by default in all STEP systems; however, it could have been deleted. Check that the
classification exists via the workbenchGoto field as shown below.

If the classification does not exist, open the 'Configuration-Export.xml' file in a text or XML editor, change the
value for the 'ClassificationReference' element 'ClassificationID' attribute to the ID of the Classification you
wish to have the Export Configuration imported into and save the changes.

3. In the STEPWorkbench, select Import > Data… from the 'File' menu.
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4. In theSelect Configuration step of the Import Manager, click theNext button.

5. In theSelect Data Source step of the Import Manager, click the ellipsis button ( ), browse to where the
'Configuration-Export.xml' file is saved, select it and click theNext button.

6. In theSelect Format step of the Import Manager, STEP should automatically recognize the file as a
STEPXML file. Confirm that Format is 'STEPXML' and clickFinish.
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7. In theSave Import Configuration dialog, uncheckSave Options if selected and clickOK to start the import
process.

8. After the import process has finished, locate the 'Configuration-Export' Export Configuration. For example, you
can use the STEPWorkbenchGoto field as shown below.

Using the Configuration-Export Export Configuration
The 'Configuration-Export' export configurationmust bemodified so that the exported STEPXML file will include
all objects required for the file to be imported on the target systemwithout errors. Follow the steps below to
configure and run the export.

1. Locate the 'Configuration-Export' file in the STEPWorkbench Tree, right-click it, and selectExport data…
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2. In theSelect Objects step of the Export Manager, data nodes (Classifications, Entities, and Products) that are
required for the configuration to be successfully imported on the target systemmust be added. For this
exercise, it will make sense to launch an additional workbench instance so that it is possible to add objects in
the Export Manager in one and browse the Tree and SystemSetup in another. The nodes that must be added
are:

l All Classifications holding Export Configurations (immediate parents)
l All Classifications holding Import Configurations (immediate parents)
l All Classifications holding Bulk Update Configurations (immediate parents)
l All Classifications holding Image Conversion Configurations (immediate parents)
l All Classifications holding Transformation Lookup Tables (immediate parents)
l All Classifications / products / entities referenced by Privilege Rules on User Groups (it is not necessary to
add the super type specific root nodes 'Product hierarchy root,' 'Classification 1 root,' 'Entity hierarchy root,'
'CollectionGroup root,' 'eCatalog root,' etc. that will exist in advance on the target system)

l Entities and Products referenced fromMatch Codes (Category)
l All Classifications referenced directly fromSupplier User Groups (Supplier section on theGroup tab for
Supplier User Groups)
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Note:With this export configuration, only the IDs and Names of these nodes and their ancestors up to the
type specific root will be exported (i.e., no attribute values, references, etc.).

ClickNext once all required nodes have been added.

3. In theSelect Format step of the Export Manager, under 'Export Data for Selected Contexts,' select the
Contexts for which data should be exported. Notice that this is only relevant if the configuration objects and
data nodes are dimension dependent (e.g., language-specific attribute names and LOV values). Once done,
clickNext to continue.
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4. In theAdvanced step of the Export Manager, make sure thatWorkspace is set to Main and clickNext.

5. In theSelect Delivery Method step, ensure that the 'File' option is selected and clickFinish.

6. Select theSave Options checkbox to save the configuration changes for later use and clickOK to start the
export process.

7. ClickGo to process in the dialog that appears.

8. Once the export process has completed, click the save icon in the lower right corner of the background process
editor to save the file to your local hard drive.
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Importing the Configuration on the Target System
This section describes how to import the exported STEP configuration on the target system. Follow the steps
below to import the configuration on the target system.

1. Assuming that the target system has not earlier been used, only a single Context with ID 'Context1' will exist in
advance, and if the exported STEPXML file was not exported from aContext with the same ID, the STEPXML
file must bemodified. Open the exported STEPXML file in a text or XML editor. If the value for the 'STEP-
ProductInformation' element 'ContextID' attribute is not 'Context1,' change it to be so and save themodified
file.

2. Launch the STEPWorkbench for the target system and select Import > Data… from the File menu.

3. ClickNext in theSelect Configuration step of the Import Manager.

4. In theSelect Data Source step of the Import Manager, click the ellipsis button ( ), browse to where you
have saved the STEPXML file exported from the source system, select it, and clickNext.
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5. In theSelect Format step of the Import Manager, STEP should automatically recognize the file as a
STEPXML file. Confirm that Format is 'STEPXML' and clickFinish.

6. In theSave Import Configurationwindow, uncheckSave Options if selected, and clickOK to start the
import process.

7. ClickGo to process in the dialog that appears and inspect the execution report for warnings and errors.
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Taking Post Import Actions
After the configuration has been imported, it may be necessary to perform a number of additional manual steps as
described below.

l It is currently not possible to transfer Workflow Profiles via STEPXML. If Workflow Profiles have been defined
in the source system, thesemust be re-createdmanually on the target system.

l Asset Push Configurations are deliberately not exported as it is not currently possible to transfer the parent
Asset Push Event Queue type via STEP XML. The event queue(s) must be createdmanually on the target
system after which the Asset Push Configurations can be transferred via STEPXML or recreatedmanually.
The screenshot below shows an Asset Push Event Queue and two Asset Push Configurations in the
workbench SystemSetup.

If Asset Push Configurations are to be transferred via STEPXML, these can be exported to STEPXML via the
Export Manager and the STEPXML format plugin as shown below (blank selection, 'No,' or 'None' for
everything except for 'Include Asset Push Configurations,' whichmust be set to 'All').
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l User objects have deliberately been left out. Usersmaintained in STEP that are referenced from Integration
Endpoints and Event Processors and used for M2M integrationsmust be createdmanually after import. It is
expected that User objects representing human users will be automatically created in the target system via an
IDP integration with user synchronization.

l Scheduled background processesmust be recreated on the target system. This includes scheduled exports,
scheduled data profiling andWorkflow deadlinemonitoring.

l If the configuration has been imported on an empty target system, all Integration Endpoints, Event Processors,
Gateway Integration Endpoints, and Keys are disabled andmust be enabledmanually. Prior to enabling
integrationswith external systems, check that the target system is configured to receive from / publish to the
correct external system. Any passwords stored in these configurationsmust be re-enteredmanually.

l As data is imported in theMain workspace, data nodesmust be approved to also be reflected in the Approved
workspace.

Sample Data: Export and Import
This section describes how to export sample data from the source system and subsequently import it on the target
system.

A template export configuration 'ProductDataSample-Export' is supplied with this guide in the STEPXML file
'ProductDataSample-Export.xml.' As the name indicates, the export configuration ismeant to be used for
exporting product sample data with related classifications and assets, meaning that it is not directly applicable for
Customer MDM systems. A separate section 'Exporting Customer MDMSample Data' describes how to export
Customer MDM sample data.

Importing the ProductDataSample-Export Export Configuration
The 'ProductDataSample-Export' export configuration supplied in the STEPXML file 'ProductDataSample-
Export.xml' can be imported on the source system following the exact same procedure used for importing the

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 117



'Configuration-Export' export configuration. See the Importing the Configuration-Export Export
Configuration section above.

Using the ProductDataSample-Export Export Configuration
The ProductDataSample-Export export configurationmakes use of the Advanced STEPXML export format plugin
with the following instructions.

<?xml version='1.0'?>
<STEP-ProductInformation>

<Assets ExportSize="Minimum">
<Asset IncludeParentClassifications="true"/>

</Assets>
<Classifications ExportSize="Minimum">

<Classification IncludeParent="true"/>
</Classifications>
<Products ExportSize="Referenced">

<Product IncludeParent="true"/>
</Products>

</STEP-ProductInformation>

When one or more products are selected as the root objects for the export, these instructionswill cause the
following objects to be exported:

l The selected product objects
l All ancestors for the selected products up to the product hierarchy root
l All descendants of the selected products
l All products referenced from the selection or descendants and the ancestors for these referenced products up
to the product hierarchy root

l All classifications that the selected products and their descendants are linked into and the ancestors for these
classifications up to the classification hierarchy root

l All assets referenced from the selected products and their descendants (asset objects, no content)
l Further, if the export is run on an In-Memory enabled system, all classifications that the referenced assets are
linked into and their ancestors up to the classification hierarchy root

If the sample product data references entities, referenced entities and their ancestors can be included by
extending the output template to be:

<?xml version='1.0'?>
<STEP-ProductInformation>

<Assets ExportSize="Minimum">
<Asset IncludeParentClassifications="true"/>

</Assets>
<Classifications ExportSize="Minimum">

<Classification IncludeParent="true"/>
</Classifications>
<Entities ExportSize="Minimum">

<Entity IncludeParent="true"/>
</Entities>
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<Products ExportSize="Referenced">
<Product IncludeParent="true"/>

</Products>
</STEP-ProductInformation>

Notice that when importing a file produced with the ProductDataSample-Export export configuration, it is
expected that the import processwill report errors for missing reference and product classification link targets.
Thus, while the template will cause referenced objects and their ancestors to be included in the export, the
template will not be applied recursively to the referenced / linked objects. That is, the objects that these exported
objects reference are not included in the produced file. As a result, these objects will bemissing from the imported
file.

There aremultiple different ways tomake the initial sample product selection. This guide focuses on two.

The first option is to simply select one or more category / family product nodes.With the template export
configuration, all product nodes below the selectionswill be exported, so use the workbenchSearch Below
feature to ensure that the number of product objects below the selections is not too large.

If a wider spread of product sample data is required, it is possible to select a category higher in the hierarchy that
would contain toomany product objects to be exported fully and sample products below that to use as the
selection. Follow the steps below to create a Collection with the sample products.
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1. Right-click the desired category in the STEPWorkbench Tree and selectSearch Below from the context
menu (as shown above).

2. In theSearch tab, click the button with the green plus sign to add another criteria to the search.

3. Click the search criteria type selector and chooseObject Type from themenu.

4. Select your leaf product object type.

5. Add another criteria of the typeSample Result, and set the desired sample result size.

6. Execute the search.
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7. Click theSave as Collection button at the bottom of the search panel to store the result in a Collection.

After having decided which approach to use (and having created the collection with sample data, if this is the
desired approach), follow the steps below to export the sample data.

1. Locate the imported 'ProductDataSample-Export' export configuration in the STEPWorkbench Tree, right-
click it and selectExport data….
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2. In theSelect Objects step of the Export Manager, depending on which approach you have chosen, either
select the root nodes for the sample product hierarchies you would like to export or select the Collection
created earlier and clickNext.

3. In theSelect Format step, under Export Data for Selected Contexts, select the Contexts for which data
should be exported if there is dimension dependent data. ClickNext to continue.
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4. In theAdvanced step, make sure thatWorkspace is set to Main and clickNext. It might be relevant to export
data fromApproved, but this then requires that the produced STEPXML file ismanuallymodified prior to being
imported.

5. In theSelect Delivery Method step of the Export Manager, ensure that the File option is selected and click
Finish.

6. Select theSave Options checkbox to save the configuration changes for later use and clickOK to start the
export process.

7. ClickGo to process in the dialog that appears.

8. Once the export process has completed, click the save icon in the lower right corner of the background process
editor to save the file to your local hard drive.
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Exporting Customer MDM Sample Data
If sample data instead needs to be exported from aCustomer MDM systemwhere data primarily ismodeled using
entities, use the same export configuration and replace the Advanced STEPXML instructions like the following.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Entities ExportSize="Referenced">

<Entity IncludeParent="true"/>

</Entities>

</STEP-ProductInformation>

Notice that, depending on the datamodel, it may be relevant to use a combination of these instructions and the
product sample data instructions in the template (if the entities, for example, have referenced assets or reference
classifications).

AsCustomer MDM setups often have large amounts of entities below the same parent node (e.g., all customer
contacts below the same parent node), it is advanced to always use the sample search approach described above
using a search that samples entities instead of products.

Importing the Sample Data on the Target System
The exported sample data can be imported on the target system in exactly the sameway as the configuration. See
the Importing the Configuration Export on the Target System section above.

Note: The configurationmust be imported before sample data.

For more information, also see theMaintaining Partial Data Sets on Lower Level DTAP Environments topic
in this section of documentation.
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